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Organizational Plan Mode
This section of the documentation on the Organizational Management component contains
information on the following views:

• Organizational and Staffing

To access this maintenance interface, choose Human resources → Organizational
Management → Organizational Plan → Organization and Staffing from the SAP
Standard Menu. Select the Organization and Staffing view by choosing Goto →
Switch view.

• Organizational and Staffing (Workflow)

To access this maintenance interface, choose Human resources → Organizational
Management → Organizational Plan → Organization and Staffing from the SAP
Standard Menu. Select the Organization and Staffing (Workflow) view by choosing
Goto → Switch view.

• General Structures

To access this maintenance interface, choose Human resources → Organizational
Management → Organizational Plan → General Structures from the SAP Standard
Menu.

• Matrix

To access this maintenance interface, choose Human resources →
Organizational=Management → Organizational Plan → Matrix from the SAP Standard
Menu.
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Organizational Management
Purpose
In order to carry out numerous business and human resources processes, you need an
organizational plan, that is, a functional structure representing your enterprise based on tasks.

You need to, for example:

• evaluate headcount, current division of tasks, reporting structures in your enterprise
according to department (for example)

Evaluations of unoccupied positions

• allocate agents responsible for carrying out SAP Business Workflow tasks

Forward leave requests to agents in the personnel department

• plan possible new functional structures in Business Process (Re-) Engineering as well as
your personnel requirements or personnel costs

Planning a Department Structure

• gather information for creating the task related, functional structure, in particular for other
Human Resources components

Default values for personnel actions in Personnel Administration

• assign structural, that is task-oriented authorizations in the R/3 System

Combination of the relevant R/3 transactions for an administrator in Purchasing

Tools from the Organizational Management component also enable you to create:

• your current valid Organizational Plan [Page 11] , changes to which are archived

• additional organizational plans in other Plan Versions [Page 31]  as planning scenarios
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Organizational ManagementOrganizational Management

Organizational unitOrganizational unit
((egeg. department). department)

      PersonPerson (employee) or  (employee) or R/3 userR/3 user

JobJob

PositionPositionTask

Implementation Considerations
Organizational Management is the basis for additional Human Resources components and
functions as well as for SAP Business Workflow. The fact that these components can be
integrated should be taken into account when you are installing them.

Integration
• Installing Organizational Management enables you to use the following Human Resources

components effectively:

− Personnel Development

− Recruitment

− Compensation Management

− Personnel Cost Planning

− Training and Event Management

− Manager's Desktop

• Organizational Management also has interfaces to the following Human Resources
components:

− Shift Planning

− Capacity Requirements Planning



Organizational Plan Mode  SAP AG

Organizational Management

10 December 1999

− Personnel Administration

− Human Resources Information System

• Organizational Management also forms the basis for SAP Business Workflow. The
organizational plan you create forms the framework for a routing structure that SAP Business
Workflow uses to assign tasks to an employee.

Both Organizational Management and SAP Business Workflow are components of
Business Management.

• Finally, Organizational Management can also be used with the Controlling component to
create an enterprise organization.

Features
The Organizational Management component includes various user group-specific modes and
views with which to edit organizational plans:

• The Organizational Plan mode includes views for administrators in the Personnel or
organizational department:

− The Organization and Staffing view provides an intuitive interface for creating and editing
organizational plans.

− The General Structures view allows you to edit organizational plans with any structure
including object types which you have defined yourself (teams, for example).

− The Matrix view is for creating and editing matrix structures.

• The Organizational Plan mode also includes a view for workflow administrators:

− Organization and Staffing (Workflow) provides you with an interface that you can use
intuitively to create and edit organizational plans. This interface can be used for SAP
Business Workflow.

• Expert mode enables experienced experts object-oriented editing of organizational plans.

− Expert mode allows you to edit the characteristics of various objects and their
relationships via infotypes.

− The Simple Maintenance view in Expert Mode provides an overview of object and
structure editing.

For more information, see the documentation on Expert Mode [Ext.].

The Manager’s Desktop [Ext.] component provides managers with data on the organizational
plan of their area of responsibility and enables them to edit this information.
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Organizational Plan
Definition
Representation of the task-related, functional structure of your enterprise, created using tools
from the Organizational Management component.

This functional organizational plan differs from the administrative enterprise structure and the
personnel structure whose elements are relevant to Payroll Accounting (company code,
personnel subarea or employee group, for example). These structures are found in their
corresponding components.

Use
You can create several organizational plans in different plan versions [Page 31], this provides
you with the following options in Organizational Management [Page 8]:

• in one plan version, you depict your current valid organizational plan which you use for your
current business processes (evaluations, Workflow, personnel planning, for example).

• In additional plan versions, you can depict organizational plans as planning scenarios (for
Business Process Re-Engineering, for example).

You can compare the current organizational plan with the planning scenarios and transfer data
from the simulated structures into the current organizational plan.

Structure
Organizational plans are normally created by assigning objects of the following types to each
other:

• Organizational Unit [Page 14]

• Position [Page 20]

• Job [Page 23]

• Task [Page 27]

If you are using your organizational plan for Workflow, the following object types are also
available:

• Standard task [Page 28]

• Workflow template [Page 29]

• Task group [Page 30]
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Organizational Plan

Staff

assignment

Organizational structure

Organizational unit A

Employee 1

Unoccupied position

Organizational unit B

Employee 2

Employee 3

Employee 4

Employee 5

Unoccupied position

Organizational unit C

The main elements of an organizational plan are

• an organizational structure [Page 16] , with which the reporting structure and task distribution
are created using organizational units (departments, for example)

• Staff assignments [Page 18]  for each organizational unit, in which the current persons
(employees), users and vacancies are listed

Integration
Organizational plans are generally related to objects from other components.

• If Integration with Personnel Administration [Ext.] is active, the personal data for the staff
assignments comes from the Personnel Administration component.

These functional (organizational plan) and administrative (personnel and enterprise
structures) structures come into contact if a person is assigned to an organizational plan
(as the holder of a position) as well as an enterprise or personnel structure (that is, to a
personnel subarea etc.).

• If the enterprise structure [Ext.]  is active, account assignment data can be obtained from
Controlling.
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Organizational unit
Definition
Represents a functional unit in your enterprise, marketing department, for example. According to
how tasks are divided up within an enterprise, this could be a department, group or project team,
for example.

Organizational units differ from other units in an enterprise such as personnel areas, company
codes, business areas etc. These are used to depict structures (administration or accounting, for
example) in the corresponding components.

Use
You depict the functional units of your enterprise with  organizational units. You create an
organizational structure [Page 16]  by assigning these organizational units to each other. The
highest organizational unit in an organizational structure is the root organizational unit.
You can store characteristics for each organizational unit. These can be

• evaluated using reports

• inherited by subordinate positions (work schedules, for example)

Structure
To define characteristics of an organizational unit, you can store time-specific data for the
following areas in the Organization and Staffing view:

• Basic Data

• Account Assignment

• Cost distribution

• Address

• Work schedule

• Quota planning

In the Organization and Staffing (Workflow) view, you can store data on the following:

• Basic Data

• Account Assignment

See also:
Editing the Organizational Structure [Page 58]

Integration
You can create staff assignments [Page 18]  for every organizational unit within an organizational
structure.

You can relate an organizational unit to a cost center. For more information, see Enterprise
Organization [Ext.].
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Organizational Structure
Definition
Representation of the reporting structure and the distribution of tasks using organizational units
(departments, for example) in an enterprise.

Use
If you want to use Organizational Management and want to create an organizational plan [Page
11] , you must create the basic parts of an organizational structure.

Organizational Structure

Executive Board

Production

Human Resources

Administration

Payroll

Financial Accounting

Marketing + Sales

Orgnanizational units

Depending on how you want to use Organizational Management, you must decide which units
you want to include in your organizational structure. For a rough depiction, you can restrict the
structure to the main departments. For a more detailed depiction, you can also include
subsections and work groups, for example.

According to this organizational structure, you can execute evaluations data, or , in Workflow,
you can search for the agent of a task.

You carry out assignments and restrictions in the representation of an organizational structure.
For more information, see Working with Screen Areas [Page 32].

See also:
Editing the Organizational Structure [Page 58]
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Structure
An organizational structure is made up of organizational units [Page 14] , which represent the
departments, work groups etc. in your enterprise.

Integration
For each organizational unit which is an element of an organizational structure, you can create
and edit staff assignments [Page 18] .
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Staff Assignments
Definition
All the persons (employees) and positions belonging to an organizational unit in the past, present
and future.

Use
You can create staff assignments for each organizational unit if you are creating an
organizational plan [Page 11] .

Staff Assignments

Person (employee)

Unoccupied positions

Organizational units

Human Resources

Michael Fonda

Administration

Anna Corta

Maria Bent

Administrator

Peter Nielsen

You use staff assignments to represent the reporting structure and task distribution in your
enterprise.

Using staff assignments, you can, for example, run reports for positions and employees or, in
Workflow, you can use staff assignments to determine agents for specific tasks.

You carry out assignments and restrictions in the representation of an organizational structure.
For more information, see Working with Screen Areas [Page 32].

See also:
Editing Staff Assignments [Page 83]

Structure
Staff assignments list all persons [Page 24]  (employees) for an organizational unit, who occupy
a position [Page 20]  as well as all those who do not occupy positions [Page 20] . As well as this,
additional time-specific data on these elements of a staff assignment are displayed.
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Integration
You can assign a person (employee) to a position within an organizational unit in Organizational
Management or in Personnel Administration.

Data on a person which is displayed in the staff assignments comes from Personnel
Administration and Personnel Development.
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Position
Definition
Represents a post which can be occupied by a person (employee) in the staff assignments of an
organizational unit, purchasing administrator, for example.

Positions differ from jobs. A job [Page 23] is not concrete but rather the basis for the creation of
various positions with similar tasks and characteristics.

Use
You represent the personnel capacity (headcount)of an organizational unit using positions. By
representing the current status of an organizational unit and foreseeable requirements, you
create the basis of the staff assignments [Page 18] . Only when you have created a position, can
you assign persons [Page 24]  or users [Page 25] and in so doing complete the staff
assignments.

Positions can have the following statuses:

Position status

Status of position Icon in staff
assignments

Text in person/user
column

Staffing status in
detail area

occupied Name

occupied by more
than one person

Name

added during
preview period

e.g.  

goes during preview
period

e.g.  

newly hired person
(employee)

e.g.  

occupied, vacancy is
filled

Name Vacancy filled or
withdrawn

occupied and vacant Name Vacancy to be filled

unoccupied and
vacant

vacant Vacancy to be filled

unoccupied and not
vacant

not vacant
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unoccupied and not
vacant, as vacancy
has been withdrawn

not vacant Vacancy filled or
withdrawn

occupied and
obsolete

Name Obsolete

occupied by more
than one person and
obsolete

Name Obsolete

unoccupied and
obsolete

not vacant Obsolete

A position is

•  occupied, if a person (employee) or user is assigned to it

•  vacant, if a person (employee) is being found for it The position is marked as vacant in
applicant administration in the Recruitment component.

•  unoccupied and not vacant, if no person (employee) is being found for it

•  obsolete, if the position will no longer be required in the future

A position can be flagged as Chief position. Chief positions are evaluated in SAP Business
Workflow. For more information, see Role for Determining a Manager [Ext.].

You enter all this data according to exact dates.

You can store characteristics for each position. These can be

• evaluated using reports

• used as default values when the position is filled by an employee (planned compensation,
working time, for example)

Structure
To define characteristics of a position, you can store time-specific data for the following areas in
the Organization and Staffing view:

• Basic Data

• Account Assignment

• Address

• Cost distribution

• Work schedule

You can store data on the following in the Organization and Staffing (Workflow) view:

See also:
Editing Staff Assignments [Page 83]
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A position does not only inherit its tasks and characteristics from this direct assignment. It can
also be assigned tasks and characteristics by inheriting them from a job [Page 23]  or directly or
indirectly from the organizational unit that it belongs to.

Integration
You can assign a person (employee) to a position within an organizational unit in Organizational
Management or in Personnel Administration.

Data on a person (employee) which is displayed in the staff assignments comes from Personnel
Administration.

Vacant positions are used in Recruitment.



 SAP AG Organizational Plan Mode

Job

December 1999 23

Job
Definition
Resource for creating positions.

Positions [Page 20] are concrete and can are held by persons in an enterprise (purchasing
administrator, for example). Jobs, in contrast, are classifications of functions in an enterprise
(administrator, for example), which are defined by the assignment of characteristics. Jobs serve
as job descriptions, that apply to several positions with similar tasks or characteristics.

Use
When creating a new position (purchasing administrator, for example), you can relate it to a 
job that already exists (administrator, for example). The position then automatically inherits the
tasks and characteristics of the job.

If there is no corresponding job, create one and assign it tasks and characteristics. This will then
be available when you add new positions.

This relationship will make it easier for you to create positions that are similar or the same, as
you will not have to assign tasks and characteristics to each individual position. You can also
assign additional tasks and characteristics directly to positions.

You have 20 administrators in your enterprise. Each one holds a position
(purchasing administrator, for example). This position is described by the job
administrator and the tasks and characteristics that belong to it. In addition to this,
each position (purchasing administrator, for example) can be assigned specific tasks
and characteristics (ordering materials, for example), which differentiate it from other
positions (personnel administrator, for example).

Structure
You can store basic data for a job.

See also:
Editing Jobs [Page 75]

You can store additional characteristics for a job in expert mode [Ext.].
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Person
Definition
An individual, who is listed as an employee in Personnel Administration.

For more information, see Personnel Administration [Ext.].

Use
By assigning a  person (employee) to a position [Page 20] , you determine,

• where a person (employee) is functionally assigned in your enterprise

• which tasks a person (employee) performs

Structure
A person (employee) can have tasks assigned to them.

In the Organization and Staffing view, you can display data on the following:

• Basic Data

• Qualifications

In the Organization and Staffing (Workflow) view, you can display data on the following:

See also:
Editing Staff Assignments [Page 83]

Integration
By assigning a person (employee) to a position, you implement integration between
Organizational Management and Personnel Administration, as long as it is set up in Customizing.
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Users
Definition
ID of an R/3 user. Users are maintained in User Maintenance.

Use
By assigning a  user to a position [Page 20] , you determine,

• where an R/3 user is functionally assigned in your enterprise

• which tasks an R/3 user performs

• which R/3 users are to be forwarded tasks in a workflow

Structure
You can display basic data on a user.

See also:
Editing Staff Assignments [Page 83]
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Tasks
Definition
Activity which is performed within an organizational unit.

Use
Using  tasks [Page 27] , you can describe the task profile of organizational units in the
Organization and Staffing view.

Using  standard tasks [Page 28],  workflow templates [Page 29], you can also determine
responsibility for tasks relevant to SAP Business Workflow [Ext.], so that the correct agent may
be found.

You can assign a task to

• an  organizational unit, if it is to apply to all subordinate positions

• a  job, if it is to apply to all positions described by the job

• a  position, if it id to apply to those persons (employees) or users who hold the position

• a  person (employee), if it is to apply to this person

• a  user, if it is to apply to this user

You can also combine tasks to form task groups [Page 30].

See also:
Editing Tasks [Page 109]

You can store additional characteristics for a task in expert mode [Ext.].
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Tasks
Definition
A description of an activity in Organizational Management which is performed within an
organizational unit. If a task has been assigned an object method, it can have the function of a
client-, plan version-, and time dependent single step task (customer task) in SAP Business
Workflow.

Use
In Organizational Management, you can assign an organizational unit, job, position, person
(employee) or user a task in order to describe their function in your enterprise. A task which you
assign, represents a characteristic of an object.

In SAP Business Workflow, a task, which has been assigned an object method can be used as a
customer task. For more information, see Definition of a Single Step Task [Ext.].

Structure
To define characteristics of a task, you can store the following time-specific data:

• Name

• Description
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Standard Tasks
Definition
Client-, plan version- and time independent single step task in SAP Business Workflow.

Use
A standard task can be used both as a single step task or as part of a workflow definition. They
are only available in the Organization and Staffing (Workflow) view.

For more information, see Definition of a Single Step Task [Ext.].

Structure
You can store basic data for a standard task.
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Workflow Templates
Definition
Client-, plan version- and time independent multistep task in SAP Business Workflow.

Use
A workflow template can be used directly or as a model for a customer-specific multistep task.
Workflow templates are only available in the Organization and Staffing (Workflow) view.

For more information, see Definition of a Multistep Task [Ext.].

Structure
You can store basic data for a workflow template.
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Task Groups
Definition
Hierarchical combination of tasks that are connected logically or by content.

Use
Task groups are used in SAP Business Workflow. They are only available in the Organization
and Staffing (Workflow) view.

For more information, see Definition of a Task Group [Ext.].

Structure
You can store basic data for a task group.
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Plan Versions
Use
Plan versions are scenarios in which you can create organizational plans.

• In the plan version which you have flagged as the active plan version, you create your
current valid organizational plan. This is also the integration plan version which will be used if
integration with Personnel Administration is active.

• You use additional plan versions to create additional organizational plans as planning
scenarios.

As a rule, a plan version contains one organizational structure, that is, one root organizational
unit. It is, however, possible to create more than one root organizational unit, that is more than
one organizational structure in a plan version.

For more information on creating plan versions, see the Implementation Guide (IMG), under
Personnel Management → Global Settings in Personnel Management → Plan Version
Maintenance.

Using report RHCOPL00, you can copy objects from one plan version to another. For more
information, see the report documentation.

Report RHCOPLPT allows you to compare plan versions with one another. For more information,
see the report documentation.

Activities
To select a plan version in the Organization and Staffing and the Organization and Staffing
(Workflow) views,

• choose Settings → Plan version → Active, to edit the active plan version

• choose Settings → Plan version → Alternative, to edit another plan version
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Working with Screen Areas
Purpose
You use the user interface in the Organization and Staffing or Organization and Staffing
(Workflow) view to create, display and edit organizational plans.

The user interface is divided into various areas, each of it which fulfills specific functions.

Search area

Detail areaSelection area

Overview area

Each time you access the Organization and Staffing or Organization and Staffing
(Workflow) views, the objects that you edited last are automatically called up, though
(if appropriate) with a new date. You can continue editing the objects directly.

Prerequisites
You are familiar with Validity [Page 35].

You have decided to use either the Organization and Staffing or the Organization and Staffing
(Workflow) view. To select the view you want, choose Goto → Switch view.

Process flow
A typical work process could look like the following:

1. In the Search area, find [Page 41]  one or more objects, which you want to display or edit, for
example.

− a complete organizational structure
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− all objects of a certain object type, positions, for example

− one or more objects of a certain object type, for example, a particular organizational unit

2. The objects found will be listed in the Selection area. Select one of these objects

− by double clicking on it, if you want to display [Page 44]  the object itself including its
environment in the overview area and its characteristics in the detail area

− by clicking on it, if you want to assign [Page 50]  it to another object using drag & drop,
you can assign a position to an organizational unit, for example

3. In the Overview area

− the selected object including its environment is displayed:

Depending on object type, the environment can be displayed as

• an organizational structure

• a report hierarchy

• staff assignments as a list or as a structure tree

• a task assignment

• an organizational assignment

•  a job assignment

•  a task hierarchy

• an agent

− you can, if required

• Switch between these displays of the object environment by choosing 

• create [Page 47], copy [Page 49], assign, move, reposition [Page 50],
terminate/delete [Page 52] new objects

• select another object

4. In the Detail area, characteristics of the selected object are displayed [Page 44] on tab
pages. You can edit [Page 44] the characteristics of this object or add new ones, as required.

Using  , you can hide the detail area, so that you can enlarge the overview area. You
can display the detail area again using .

Which tab pages are displayed can be determined in Customizing. For further
information, see the Implementation Guide (IMG) under Personnel Management →
Organizational Management → Framework → Detail area.
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Validity
Use
An enterprise’s organizational plan is constantly undergoing change. For this reason,
Organizational Management allows you to edit the organizational structure, staff assignments as
well as individual objects according to key dates.

You must be familiar with the concept of validity as it is relevant to every step in the Organization
and Staffing and Organization and Staffing (Workflow) views.

Prerequisites
So that you can use validity completely, make sure

• that you know the period for which you want to find and select objects

• when you are creating objects and object characteristics, that you specify the period in which
they are to be valid

• when you are assigning objects and object characteristics that you specify the period in
which the assignments are to be valid

Features
You determine the validity of an object or assignment when you create it. You control the display
of objects by entering key dates and preview periods. For more information, see Validity of
Objects and Assignments [Page 36]

You determine the validity of object characteristics when you create them. Changes to data are
presented in periods. For more information, see Validity of Object Characteristics [Page 40].



Organizational Plan Mode  SAP AG

Validity of Objects and Assignments

36 December 1999

Validity of Objects and Assignments
Use
So that the presentation of your organizational plan can be exact, objects and assignments
between objects exist for a specific period of time. You determine the validity period of objects
and assignments when you create them, as required.

Features
Key Date and Preview Period
A key date and a preview period are always set in the Organization and Staffing and the
Organization and Staffing (Workflow) views.

• Every time you log on, the current date is set as the key date. You can change the key date.
Data valid on the date you have selected is displayed.

• When you logon initially, a preview period of 3 months is set, that is, all changes to data that
happen in this period are displayed. You can change this preview period. Next time you log
on, the preview period which you selected is set.

System Response
When you create [Page 47] an organizational unit or position in the overview area,

• the validity of the object begins with the key date set, this can be moved forward in the detail
area

• the assignment begins with the key date set

If you want the validity of the organizational unit, position or assignment to be restricted, you can
terminate them. For more information, see Terminating Organizational Units [Page 73]. or
Terminating Positions [Page 96]

If you are creating a job or a task, specify the validity date in the dialog box. For more
information, see Creating Jobs [Page 76] or Creating Tasks [Page 110]. Task and job
assignments begin on the key date set.

If you are finding objects [Page 41] in the search area, the system selects all the objects that
exist on the key date and preview period you set, and presents them for selection in the
selection area.

Objects whose validity begins only in the preview period set, are indicated by a  in the
selection area. Objects, whose validity ends in the preview period, are indicated by a .

If you have selected an object to be displayed [Page 44] , in the overview area, according to
object type

• the relevant organizational structure and the organizational units assigned to it on the key
date or in the preview period is displayed.

• the relevant staff assignments and the positions, persons (employees) or users assigned to it
on the key date or in the preview period are displayed.
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• the relevant staff assignments and the positions, persons (employees) or users from an
organizational unit assigned to the selected job on the key date or in the preview period are
displayed.

• the relevant task assignment and the objects assigned to it on the key date or in the preview
period is displayed.

Objects whose assignment to another object begins only in the preview period set, are indicated
by a . Objects whose assignment to another object ends in the preview period, are indicated
by a .

If you assign [Page 50]  an object to another object in the overview area or detail area, the new
assignment applies from the key date to the end of the validity of an object. If you have activated
Query time period for organizational changes, assignments of organizational units and positions
are valid in the period you entered in the Query time period for organizational changes dialog
box.

Assignments can only be made in the detail area in key date mode. Change the
mode by choosing .

Activities
Before you perform a step, check the key date and preview period that are set. Change the
settings as required. For more information, see Selecting a Date and Preview Period [Page 38].

Activate/deactivate Query Time Period for Organizational Changes [Page 39]
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Selecting a Date and Preview Period
Use
To display and edit data according to key dates and time periods, select a key date and preview
period.

Procedure
1. Choose Settings → Date and Preview period (or ).

The Define Date and Preview Period dialog box appears.

2. Enter the key date in the Start Date field.

3. In the Preview period field, enter the preview period.

When you confirm your entries with Return, the preview period you selected is displayed.
Correct your entries as required.

4. Confirm your entries by choosing .

Result
You have set a date and a preview period. You can change these settings at any time.
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Activating/Deactivating Query Time Period
Use
The validity of assignments normally begins on the key date you have specified. Alternatively,
you can activate a dialog box, in which you can enter any validity date when assigning objects
(this does not apply when you are assigning persons (employees) or users to positions).

Procedure
1. Choose Settings → Query time for organizational changes

The Query time for organizational changes dialog box appears.

2. Select the Query time for organizational changes field, if you want to enter a validity date
when you are assigning objects. Otherwise, you can deselect this field.

3. Confirm your entries by choosing .

Result
If you have activated the time period query, a dialog box will appear when you move or assign
objects, you can enter the validity of the assignment in this dialog box.

If you have deactivated the time period query, the validity of the assignment is determined
according to the key date.
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Validity of Object Characteristics
Use
You store the characteristics of an object on tab pages in the detail area. The characteristics of
an object can change with time. For this reason, an exact representation of your organizational
plan is available according to a specific time period. You determine the validity of object
characteristics, according to your requirements, when you create them.

Features
Key Date and Periods
In the Organization and Staffing and the Organization and Staffing (Workflow) views

• period mode is always set, which displays all existing periods

• key date mode is set, this displays the key date and the current period

System Response
Each time data is changed using a tab page in the detail area, a new period is created for this
tab page. It is valid from the date in the Valid from field and until the date in the Valid to field. The
previous period is automatically terminated on the day before the new period.

A new period is also created, if you make a change outside the detail area, which affects the tab
pages, for example, if you create a new position in the overview area.

In key date mode, if more than one period exists for a tab page, this is indicated by a . This
indicated that assignments which you are making are valid alongside the current period. If there
is only one period, this is indicated by a . In this case, the duration of the new assignment
includes the duration of the current period.

Activities
Scroll through the existing periods for object characteristics using  and  or  and .
Alternatively, you can use  to select a period directly.

When you are changing data, enter the date from when the data is to be valid in the Valid to field,
and the date until it is to be valid in the Valid to field.

By selecting  switch to key date mode, to assign objects in the detail area.
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Searching for Objects
Use
In the Search area, find one or more objects, which you want to display or edit, for example.  The
object type you are looking for depends on the view you are in.

In the Organization and Staffing view, you can search for the following object types:

  Organizational unit,  person,  user,  position,  job and  task

In the Organization and Staffing (Workflow) view, you can search for the following additional
object types:

 standard task,  workflow template and  task group

There are various search functions available to help you search according to object type:

• Search Term

• Ad Hoc Query

• Structure search

Additional object types (  workflow task, for example) and search functions can be
added as required. You can also adjust the sequence of the search functions. For
further information, see the Implementation Guide (IMG) under Personnel
Management → Organizational Management → Object Manager.

You can restrict the hit list of a search according by combining selection criteria. You can save
this combination as a search variant and delete if required.

Prerequisites
Objects that you want to search for must exist in the current plan version [Page 31] . Create new
objects [Page 47] as required.

You are familiar with Validity [Page 35]. Select a key date and preview period.

The required object types and search functions are set up.

Procedure
Searching for an Object Using a Search Term
1. Select an object type.

The Search for <object type> dialog box appears.

2. Enter a name. This can be a name, abbreviation or numeric ID. You can also search using
the entry  *  .

3. Restrict the number of hits, if required. Enter whether the object you are looking for is
directly or indirectly assigned to another object.

4. Choose  Search.
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The results of the search are displayed in the selection area. The display in the
overview and detail areas does not change.

5. If required, you can start an additional search for the same object and add the hits to the first
results by choosing  Add.

6. You can also select [Page 44]  an object to display or edit.

Searching for an Object Using Ad Hoc Query
1. Choose Ad Hoc Query

The Determine objects of type <object type> dialog box appears. For more information,
see Human Resources Ad Hoc Query [Ext.]

2. You can also select [Page 44]  an object to display or edit.

Searching for Objects using Structure Search
1. Choose Structure search.

All objects found of the object type concerned are displayed according to their
assignment in the organizational plan in a structure tree in the selection area.

You can refresh the list of hits in the selection area as required by choosing . This
is recommended if, for example, you have created a new object shortly beforehand.

2. Expand the structure down to the object in question.

To display objects that are not related, choose .

3. You can also select [Page 44]  an object to display or edit.

Creating Search Variants
1. Search for the object using one of the search functions.

The objects that match the selection criteria are displayed in the selection area.

2. Choose  and enter a name. Choose :

The search criteria are saved as search variants and the corresponding object type is
assigned in the search area.

3. Select the search variant you created and choose . You can check your search criteria.

Deleting Search Variants
1. Select the search variant that you want to delete.

2. Choose :

The search variant is deleted.
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Searching for Objects with Search Variants
Select a search variant. The hits are displayed in the selection area. You can also select [Page
44]  an object to display or edit.

Scrolling through Search Results
You can scroll through search results using  and .
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Displaying/Editing Objects
Use
The organizational objects in an organizational plan can be allocated numerous characteristics.
Select an object in the selection area or overview area so that you can display the
characteristics of the object in the detail area, you can also edit them, if required.

Prerequisites
You are familiar with Validity [Page 35]. Select a key date and preview period.

Under some circumstances, the detail area is hidden. To display and edit object characteristics,
you must display the detail area, by choosing .

Procedure
Selecting and Displaying Objects
You can either select objects in the selection area or in the overview area:

• In the overview area select an object by double-clicking on it.

You can only select an object from the selection area if you have searched for one or
more objects in the search area [Page 41].

The object itself is displayed in the overview area. The following displays are offered:

 Organizational unit

• Organizational structure: Structure showing the assignment of an organizational unit
to other organizational units.

• Task assignment: Structure showing the assignment of tasks and activity groups to
an organizational unit.

• Report hierarchy: Structure showing the assignment of a chief position and its holder
(person or user) to an organizational unit.

• Staff assignments (list): List showing the assignment of subordinate positions and
their assignments to an organizational unit.

• Staff assignments (structure): Structure showing an organizational structure and the
assignment of subordinate positions and their holders to each organizational unit.

 Position

• Task assignment: Structure showing the assignment of tasks and activity groups to a
position.

• Report hierarchy: Structure showing the subordinate and superior positions.

• Organizational assignment: Structure showing the assignment of a position to
superior organizational units.

 Job
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• Task assignment: Structure showing the assignment of tasks and activity groups to a
job.

• Job usage: Structure showing the assignment of positions to a job.

 Person

• Organizational assignment: Structure showing the assignment of a person to a
position to superior organizational units.

• Task assignment: Structure showing the assignment of tasks and activity groups to a
person.

• Report hierarchy: Structure showing the subordinate and superior positions and their
holders.

 Users

• Organizational assignment: Structure showing the assignment of a user to a position
to superior organizational units.

• Task assignment: Structure showing the assignment of tasks and activity groups to a
user.

 task  standard task,  workflow template and  task group

• Task hierarchy: Structure showing the assignment of a task to other tasks and
activity groups.

• Agent: Structure showing the assignment of a task to other organizational units.

You can display the exact evaluation path for the current display by choosing .

To switch between these views, select an object and choose . The displays which you
can select are displayed.

Choose  to move up a level within the structure.

• Select an object in the overview area which is to be displayed in a structure or list.

The characteristics of the object are displayed in the detail area.

Scrolling
You can scroll through the displays in the overview area using  and  . If you have already
made changes to data but have not yet saved them, you can use  and  to undo or recreate
the last change.

In the detail area, you can use  and  or  and  to scroll through the periods that exist for
an object.

Editing the Characteristics of a Job
You can edit the characteristics of the object you have selected in the detail area.

1. Select a tab page.

2. Make the appropriate entries. For more information, see  

Editing Organizational Units [Page 63]

Editing Positions [Page 87]
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Editing Jobs [Page 79]

Editing Tasks [Page 115]

3. Save your entries by choosing .

A  appears on tab pages which contain characteristics.
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Creating objects
Use
You depict the functional structure of your enterprise as an organizational plan [Page 11], by
creating organizational objects (organizational units, positions etc.) in the overview area and
assigning them to objects that already exist.

Prerequisites
To create a root organizational unit for a new organizational plan, you must be in Create mode
(Organization and Staffing Create or Organization and Staffing (Workflow) Create).

Create additional organizational objects

• in Create mode, if you are going to create additional objects straight away once you have
created the root organizational object, without leaving the mode.

• in Change mode (Organization and Staffing Change or Organization and Staffing (Workflow)
Change), if you have left create mode.

You are familiar with Validity [Page 35]. Select a key date and preview period.

Which objects you can create depends on what is displayed in the overview area. Check which
assignments can be depicted in a particular case by choosing . If necessary, switch to a
display in which you can create the object by choosing .

For more information on the displays, see Displaying/Editing Objects [Page 44].

Procedure
Creating Root Organizational Units
You are in create mode. As standard, a new organizational unit with the preset name “new
organizational unit” is created, you can use this as your root organizational object.

1. Replace the preset entries for object name and object description on the Basic data tab page
in the detail area with the name of your choice.

2. Save your entries by choosing .

You have created your root organizational unit.

Creating Organizational Objects in a Structure
1. In the overview area, select the object to which the new object is to be assigned.

2. Choose :

The Select Relationship dialog box appears.

3. Select an object type.

The object is created.

4. Edit the characteristics of the new object using the tab pages in the detail area.

According to the object type, see the following for more information,
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Editing Organizational Units [Page 63]

Editing Positions [Page 87]

Editing Jobs [Page 79]

Editing Tasks [Page 115]

Creating Positions in the Staff Assignments (list)
1. Choose :

The new position is created.

2. Edit the characteristics of the new object using the tab pages in the detail area.

You can also create new objects by copying. For more information, see Copying
Objects [Page 49].

Objects can be assigned to other objects other than when they are created. For more
information, see Assigning Objects [Page 50].
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Copying Objects
Use
You can create a new object by copying an object which already exists. When you do this, all the
characteristics of the object are copied.

Prerequisites
You are familiar with Validity [Page 35]. Select a key date and preview period.

Procedure
1. In the overview area, select the object which you want to copy.

2. Choose :

The Copy Object dialog box appears.

3. Specify the number of copies you wish to make and the validity period which is to apply to
the new objects.

4. Choose :

The new object is created. The object’s tab pages will be filled with the characteristics of
the template. The characteristics can be changed or enhanced as required.

5. Save your entries by choosing .
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Assigning/Moving/Repositioning Objects
Use
An organizational plan depicts the functional relationships in your enterprise. To depict such
relationships (the hierarchy of organizational units or the staffing of positions by persons, for
example), you assign objects to each other. You can either:

• assign objects for the first time, if they have not already been assigned

• move an object, that is, end its assignment in a structure and reassign it within this structure

• reposition an object within a hierarchy level of a structure

The following can be target positions:

• An  organizational unit can be assigned to the following:

  organizational unit  task  standard task,  workflow template and  task
group

• A  position can be assigned to the following:

  organizational unit  task  standard task,  workflow template and  task
group

• A  person (employee) or a  user can be assigned to the following:

  position,  task,  standard task,  workflow template,  task group

• A  job can be assigned to the following:

  position,  task,  standard task,  workflow template,  task group

• A  task,  standard task,  workflow template or  task group can be assigned to the
following:

  Organizational unit,  position,  job,  person,  user,  task,  standard
task,  workflow template,  task group.

Prerequisites
You are familiar with Validity [Page 35]. Select a key date and preview period.

 You can only assign  workflow templates and  task groups in the Organization and
Staffing (Workflow) view.

Which objects you can assign/move/reposition depends on what is displayed in the overview
area. Check which assignments can be depicted in a particular case by choosing . If
necessary, switch to a display in which you can carry out the assignment by choosing .

For more information on the displays, see Displaying/Editing Objects [Page 44].
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Procedure
Assigning Objects
1. Find an object, which already exists but which is not yet assigned to this structure. For more

information, see Finding Objects [Page 41].

2. Select the object that you want to assign to another object in the selection area.

3. Holding down the left mouse button, drag the object to the target position. The target position
can be an object in a structure or a field in the staff assignments (list).

The object is assigned.

4. Save your entries by choosing .

Move objects
1. In the overview area, select the object which you want to move.

2. Holding down the left mouse button, drag this object to the object you wish to assign it to.

The object is moved, and reassigned.

3. Save your entries by choosing .

Repositioning Objects
1. In the overview area, select the object which you want to reposition.

2. Choose  or , if you want to move the organizational unit up or down within the hierarchy
level.

The object is repositioned. The sequence of the objects in the hierarchy level has
changed.

3. Save your entries by choosing .
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Terminating/Deleting Objects or Assignments
Use
You can:

• Terminate organizational objects if you want to limit their validity.

• Terminate the assignment of an organizational object to another organizational object if you
want to limit the validity of this assignment.

• Delete an organizational objects, if you want to delete them completely, including their
history.

• Delete the assignment of an organizational object to another organizational object, if you
want to delete this assignment and its history completely.

Prerequisites
You are familiar with Validity [Page 35]. Select a key date and preview period. Choose key date
mode in the detail area.

Which objects/assignments you can terminate/delete depends on what is displayed in the
overview area. Check which assignments can be depicted in a particular case by choosing . If
necessary, switch to a display in which you can terminate/delete the object or assignment by
choosing .

For more information on the displays, see Displaying/Editing Objects [Page 44].

Procedure
1. In the overview area, select the object which you want to terminate/delete or whose

assignment you wish to delete.

2. Choose  if you want to terminate, or  if you want to delete.

3. Choose whether you want to terminate/delete the object or the assignment.

If you want to terminate, enter the date from which the object/assignment is to be
terminated in the dialog box, and choose .

The object / the assignment is terminated/deleted.

4. Save your entries by choosing .
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Undoing/Recreating Changes
Use
If you have already made changes to data in the overview area, but have not yet saved them,
you can use  and  to undo or recreate them.

Prerequisites
You have changed data but you have not yet saved.

A change (no assignment) in the detail area: You have confirmed the change with Return, or you
carried out another activity after the change, chosen another tab page, for example.

Procedure
1. Choose  to undo the last change.

The change is undone.

2. Choose  to recreate the last change.

The change is recreated.

3. Save your entries by choosing  when you want to finally  confirm your changes.
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Confirmation Prompt
Use
Once you have carried out a specified number of changes to data (specified in Customizing), a
dialog box appears asking whether you want to save these changes. Thus you can avoid losing
data.

Prerequisites
You define the number of steps that are carried out before the confirmation prompt appears in
Customizing. For further information, see the Implementation Guide (IMG) under Personnel
Management → Organizational Management → Framework → Set Up Confirmation Prompt.

Activities
Save data as required.
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Configuring Columns
Use
You can decide which columns are displayed in the selection and overview areas.

Prerequisites
The columns that are available are determined in Customizing. For more information, see the
Implementation Guide (IMG) under Personnel Management → Organizational Management →
Dialog control → Column configuration for “Organization and Staffing”.

Procedure
1. Choose :

The Column configuration dialog box appears.

2. Select the columns that you want to display.

Some entries represent column groups, that is, more than one column will be displayed if
you select one of these entries.

3. Confirm your entries by choosing .

Result
The columns you selected are displayed.
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Switching Maintenance Interfaces
Use
You can replace the Organization and Staffing and the Organization and Staffing (Workflow)
views with Simple Maintenance. You may want to switch if, for example, you have already used
Simple Maintenance and you want to work with the interface maintenance you are used to.

For more information on Simple Maintenance, see Simple Maintenance [Ext.].

Procedure
A: You are in Organization and Staffing or Organization and Staffing (Workflow) view and want to
switch to Simple Maintenance.

Choose Settings → Maintenance Interface. You access Simple Maintenance.

If you do not change this setting, you will automatically access Simple Maintenance when you
call up a maintenance interface in the future.

B: You want to reverse this setting. You are in Simple Maintenance

Choose Settings → Maintenance Interface. The Organization and Staffing interface appears.

When you call up a maintenance interface in future, the Organization and Staffing view will
appear.

C: You are not in one of the two maintenance interfaces, you want to select an interface.

Choose Human resources → Organizational management → Settings → Set maintenance
interface from the SAP Menu. The Set maintenance interface dialog box appears. Select a
maintenance interface and confirm by choosing . If you do not change this setting, you will
automatically access the interface you select when you call up a maintenance interface in the
future.
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Deleting User Settings
Use
An administrator can delete settings made by a user for the Organization and Staffing view.

Prerequisites
For more information, see the report documentation.

Procedure
1. Choose Human resources → Organizational management → Settings → Delete user settings

from the SAP Menu.

The Delete user settings for Organizational Management report appears.

2. Enter the name of the relevant user and select the settings you want to delete.

3. Choose :

Result
The user settings are deleted.
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Editing the Organizational Structure
Use
You want to:

• create an Organizational Structure [Page 16] as the basis for the Organizational Plan [Page
11] of your company.

• Make changes to the organizational structure or to individual Organizational Units [Page 14].

Features
In the Organization and Staffing and the Organization and Staffing (Workflow) views, you can

• create an organizational structure by creating organizational units

• display the entire organizational structure or individual organizational units

• change the organizational structure, that is, create, assign, terminate or delete organizational
units

• assign characteristics to organizational units
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Creating Organizational Units
Use
You create organizational units to create an organizational structure.

Prerequisites
You must first have created a root organizational unit. For more information, see Creating
Objects [Page 47]  and Organizational Units [Page 14].

You are familiar with Validity [Page 35]. Select a key date and preview period.

Procedure
1. Select an organizational unit (the root organizational unit, for example) from the

organizational structure in which you want to create a new organizational unit.

The organizational structure is displayed in the overview area.

For more information, see Finding Objects [Page 41] and Displaying Objects [Page 44].

2. In the overview area, select the organizational unit that you want to be the parent object of
the new organizational unit.

3. Choose :

The new organizational unit is displayed in the overview area and the tab pages for the
characteristics of the new organizational unit are displayed in the detail area.

4. Replace the default short and long descriptions on the Basic Data tab page with names of
your choice.

For more information on editing characteristics, see Editing Organizational Units [Page
63].

5. Save your entries by choosing .

For information on how to restrict the validity of your organizational unit or its
assignments, see Terminating/Deleting Organizational Units or Assignments [Page
73].

Result
The new organizational unit is created.

• The position is valid from the key date entered in the detail area or from the key date that you
entered on the Basic Data tab page.

• The organizational unit is assigned to the parent organizational unit from the key date
entered in the overview area.
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Assigning/Moving/Repositioning Organizational Units
Use
To make changes to your company’s organizational structure, you can

• assign an organizational unit that already exists to an organizational structure which it is not
already assigned to

• move an organizational unit, that is, end its assignment within the organizational structure
and reassign it within  the organizational structure

• reposition an organizational unit within a hierarchy level

You can also assign a task to an organizational unit. For more information, see
Assigning Tasks [Page 113].

Prerequisites
You have already created an organizational structure, there are further organizational units,
which are not yet assigned to this organizational structure.

You are familiar with Validity [Page 35]. Select a key date and preview period.

Select an organizational unit (the root organizational unit, for example) from the organizational
structure which you want to restructure. For more information, see Finding Objects [Page 41] and
Displaying Objects [Page 44]. The organizational structure is displayed in the overview area.

Procedure
Assigning Organizational Units
1. Find an organizational unit, which already exists but which is not yet assigned to this

organizational structure. For more information, see Finding Objects [Page 41].

The organizational unit is displayed in the selection area.

2. Select this organizational unit in the selection area.

3. Holding down the left mouse button, drag the organizational unit to the organizational unit,
which you want to assign it to in the overview area.

The organizational unit is assigned to the superior organizational unit. To see the validity
of the assignment, see Activating/Deactivating Query Time Period [Page 39].

4. Save your entries by choosing .

Moving Organizational Units
1. In the overview area, select the organizational unit which you want to move.

You can also select this organizational unit in the selection area, if it is listed.

2. Holding down the left mouse button, drag the organizational unit to the organizational unit,
which you want to assign it to in the overview area.
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The organizational unit is assigned to the superior organizational unit. To see the validity
of the assignment, see Activating/Deactivating Query Time Period [Page 39].

3. Save your entries by choosing .

Repositioning Organizational Units
1. In the overview area, select the organizational unit which you want to reposition.

2. Choose , if you want to move the organizational unit up within the hierarchy level. Choose
, if you want to move the organizational unit down within the hierarchy level.

The organizational unit is repositioned. As only the sequence of organizational units
within the hierarchy level has changed, the date of the assignment remains the same.

3. Save your entries by choosing .

Result
You have restructured your organizational structure.

For information on how to restrict the validity of an assignment, see
Terminating/Deleting Organizational Units or Assignments [Page 73].
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Editing Organizational Units
Use
You can store numerous characteristics for each organizational unit used in Organizational
Management and/or other components. Some characteristics of organizational units are inherited
by subordinate organizational units and positions if they have not been maintained.

Prerequisites
You have already created an organizational unit [Page 59].

You are familiar with Validity [Page 35]. Select a key date and preview period.

Procedure
1. Select an organizational unit. For more information, see Finding Objects [Page 41] and

Displaying Objects [Page 44].

The organizational structure concerned is displayed in the overview area, the
characteristics of the organizational unit are displayed in the detail area.

2. Select a tab page in the detail area.

3. Make the appropriate entries.

4. Save your entries by choosing .
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Basic Data (Organizational Unit)
Definition
The basic characteristics of an organizational unit.

Use
Basic data provides organizational units with a unique identity.

Structure
• Short and long descriptions

In the two organizational unit fields, enter a short and long description for an
organizational unit. These descriptions are displayed in the organizational structure, the
staff assignments, etc.

• Staff
By choosing the Staff field, you can assign a staff indicator to positions or organizational
units. A staff flag indicates that an organizational unit or position is not part of the normal
reporting structure at your company, but rather reports directly to a high level position, or
organizational unit. A position can, therefore, report directly to a member of the executive
board and an organizational unit can report directly to the executive board.

• Department
By choosing the Department field, you can assign a department indicator to
organizational units. It is only necessary to flag organizational units as departments if
integration between Organizational Management and Personnel Administration is active.

• Basic Data for Staff Assignments
Basic data on the staff assignments for an organizational unit are displayed in the Staff
assignments table. To display all staff assignments, select an organizational unit in the
overview area and choose .

• Describing Texts
You can create various texts. Select a text type and enter a text.

Integration
The fields on this tab page are integrated with infotypes from the Organizational Management
Expert Mode [Ext.] as follows:

• Short and long name: Object (infotype 1000) [Ext.]

• Staff field: Department/Staff (infotype 1003) [Ext.]

• Department field: Department/Staff (infotype 1003) [Ext.]

• Describing texts: Description (infotype 1002) [Ext.]



 SAP AG Organizational Plan Mode

Basic Data (Organizational Unit)

December 1999 65



Organizational Plan Mode  SAP AG

Account Assignment (Organizational Unit)

66 December 1999

Account Assignment (Organizational Unit)
Definition
Specification of a controlling area, master cost center, company code, business area, personnel
area and personnel subarea for an organizational unit.

Use
You specify the account assignment features of an organizational unit. Inheritance occurs as
follows:

• Account assignment features are inherited by subordinate organizational units and positions
if they have not been maintained.

• If account assignment features have been specified for a superior organizational unit, these
are overwritten by entries on the Account Assignment tab page for a subordinate
organizational unit.

Structure
• Controlling Area

You can assign a controlling area to an organizational unit.

• Cost Center
You can assign a cost center to an organizational unit. This forms the basis for Cost
Distribution [Page 94]. The cost center can only be maintained in the Organization and
Staffing view if integration with the Enterprise Organization [Ext.]  is not activated.

• Company Code
You can assign a company code to an organizational unit.

• Business Area
You can assign a business area to an organizational unit.

• Personnel Area
You can assign a personnel area to an organizational unit.

• Personnel Subarea
You can assign a personnel subarea to an organizational unit.

Integration
Data on the controlling area, cost center, company code, business area, personnel area and
personnel subarea is inherited by subordinate positions and organizational units, as long as they
have no direct assignment of their own.

Data on the controlling area, company code, business area, personnel area and personnel
subarea are used as default values in Personnel Administration.

Data on the cost center is transferred to Personnel Administration in infotype 0001.
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Whether the cost center can be maintained in the Organization and Staffing view depends on
whether integration with the Enterprise Organization [Ext.] is activated or deactivated.

The fields on this tab page are integrated with infotypes from the Organizational Management
Expert Mode [Ext.] as follows:

• Controlling area: About the Account Assignment Features Infotype (1008) [Ext.]

• Master cost center: Relationship (infotype 1001) [Ext.]

• Company code: About the Account Assignment Features Infotype (1008) [Ext.]

• Business area: About the Account Assignment Features Infotype (1008) [Ext.]

• Personnel area: About the Account Assignment Features Infotype (1008) [Ext.]

• Personnel subarea: About the Account Assignment Features Infotype (1008) [Ext.]
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Address (Organizational Unit)
Definition
Specification of a first or second address for an organizational unit.

Use
Enter detailed standard information for an organizational unit.

Structure
The first or second address for an organizational unit contains the following:

• Address supplement
You can enter an address supplement, for example a postal code or c/o address.

• Street/house number
You can enter the street and house number as a part of the address.

• Town
You can enter the name of the town or city

• Postal code
You can enter the postal code for the address.

• Country
You can enter a key which represents a particular country.

• Region
You can enter the name of the region (or the name of a state, county or province etc.) if it
is relevant to the address in a particular country. This is country-specific.

• Telephone number
You can enter the telephone number of the organizational unit.

• Fax number
You can enter the fax number of the organizational unit.

• E mail address
You can enter the e mail address of the organizational unit.

Integration
The fields on this tab page are integrated with Infotype 1028 [Ext.] from the Expert Mode [Ext.] of
Organizational Management.
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Cost Distribution (Organizational Unit)
Definition
Distribution of costs arising to several cost centers.

Use
Costs incurred by an organizational unit are usually written to the cost center directly assigned to
the organizational unit (master cost center) or the cost center inherited by the organizational unit.
For more information, see Account Assignment (Organizational Unit) [Page 66].

Create a cost distribution if you wish to distribute costs to more than one cost center. Enter which
portion of the costs you would like to distribute to which cost center. If the organizational unit is
already assigned a master cost center, the left-over share will be written to this cost center.

If the organizational unit was assigned a master cost center before it was created,
you must reconcile cost distribution with this.

Subordinate position and organizational units inherit cost distribution, if they have not been
assigned their own master cost center or cost distribution.

You will find the Cost Distribution tab page in the Organization and Staffing (Workflow) view.

Structure
In the table which is displayed, you can enter the percentage of costs that is to be distributed to
each cost center. You can also assign orders and WBS elements.

Integration
The fields on this tab page are integrated with Infotype 1018 [Ext.] from the Expert Mode [Ext.] of
Organizational Management.
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Working Time (Organizational Unit)
Definition
The time which is to be worked by persons (employees) or users that occupy a subordinate
position.

Use
You can specify which group of positions are to work for which planned working times.

You will find the Working Time tab page in the Organization and Staffing (Workflow) view.

Structure
• Work Schedule Group

You can combine positions into work schedule groups in Customizing in order to reduce
data entry time. On this tab page you can specify a work schedule for each work
schedule group that exists (and their subordinate positions).

• Work schedule
Working times are entered in this field.

• Origin
Enter the origins of the work schedule in this field. If the work schedule comes from the
rule value definition in Customizing, enter Standard Entry. If the work schedule has been
inherited from a superior organizational unit, the name of the organizational unit is
displayed.

• Percentage
The entry in this field specifies the percentage of the work schedule corresponds to the
planned working time.

• General Work Schedule
You can flag the work schedule that you have assigned to an organizational unit as the
general working time for the unit itself and for all objects under it in the organizational
structure. The general working time is assigned to all subordinate organizational units,
positions or employee groups if they have no individual working time assignment.
Individual working time assignments of subordinate objects override the work schedules
they inherit from superior organizational units.

For more information (particularly on inheritance), see Work Schedules [Ext.].

Integration
The fields on this tab page are integrated with Infotype 1011 [Ext.] from the Expert Mode [Ext.] of
Organizational Management.
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Quota Planning (Organizational Unit)
Definition
Headcount planning for an organizational unit.

Use
You can plan how many and which positions are to be assigned in the staff assignments for an
organizational unit in the future. Planning can be activated in Expert Mode [Ext.] .

The Quota Planning tab page is not available in the Organization and Staffing (Workflow) view.

Structure
• Displayed Periods

Enter the planning period. The period displayed results from settings made in
Customizing. For further information, see the Implementation Guide (IMG) under
Organizational Management → Infotype Settings → Set Up Quota Planning.

• Time Interval
You select the time interval in which the data is to appear in the table displayed. For
further information, see the Implementation Guide (IMG) under Organizational
Management → Infotype Settings → Set Up Quota Planning.

• Planning Type
You can execute several plans. Activate one of the planning types in Customizing. For
further information, see the Implementation Guide (IMG) under Organizational
Management → Infotype Settings → Set Up Quota Planning.

• Table
For each job that describes at least one position in the organizational unit, the table
displays how many positions (which are described by this job) currently belong to the
organizational unit. The amount of planned positions is also shown in the table. In active
planning, you can enter Planned in the appropriate fields.

Integration
The fields on this tab page are integrated with Infotype 1019 [Ext.] from the Expert Mode [Ext.] of
Organizational Management.
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Terminating/Deleting Organizational Units or
Assignments
Use
You can:

• terminate an organizational unit, if you want to limit the validity of the organizational unit (the
current assignment is also deleted)

• terminate the assignment of an organizational unit, if the organizational unit is no longer to be
assigned

• delete an organizational unit, if you want to delete it completely, including its history

Prerequisites
Select an organizational unit. For more information, see Finding Objects [Page 41] and
Displaying/Editing Objects [Page 44].

The organizational unit is displayed in the overview area.

Procedure
Terminating Organizational Units or Assignments
1. Choose an organizational unit from the overview area.

2. Choose

−  and then Object, if you want to terminate the validity of the organizational unit.

−  and then Assignment, if you want to terminate the assignment of the organizational
unit to a superior organizational unit

In the first case, the Terminate on dialog box appears, in the second, the Terminate
relationship dialog box.

3. Enter the date on which the organizational unit or assignment is to be terminated.

4. Confirm your entries by choosing .

The organizational unit or assignment is terminated.

5. Save your entries by choosing .

Deleting Organizational Units or Assignments
1. Choose an organizational unit from the overview area.

2. Choose

−  and then Object, if you want to delete the organizational unit

−  and then Assignment, if you want to delete the assignment of the organizational unit
to a superior organizational unit

The organizational unit or assignment is deleted.
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3. Save your entries by choosing .
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Editing Jobs
Use
You create jobs [Page 23] in order to simplify the procedure of creating positions [Page 20].

Features
You can:

• Create jobs

• Display jobs

• Assign jobs

• assign characteristics to jobs
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Creating Jobs
Use
You create jobs so that you can use them to create positions.

Prerequisites
• Check whether a suitable job exists already, so that you can avoid creating a new job: Select

one or more of the existing jobs from using the search area. For more information, see
Finding Objects [Page 41] and Displaying Objects [Page 44].

You can display data on the job you have selected in the detail area.

• You are familiar with Validity [Page 35].

• Before you create a new job, you must have specified which position you want to assign the
new job to.

Procedure
1. In the selection area, double-click on the position that you want to assign the new job to.

The Task assignments appear in the overview area.

2. Choose :

The Select Relationship dialog box appears.

3. Select the object type Job and confirm your entry by choosing .

4. In the dialog box which appears, enter the period for which the job is to be valid in the Valid
from field.

5. Confirm your entries by choosing .

The job is created and assigned to the relevant position.

6. You can enter a short and long name for the new job in the Job field of the detail area.

Save your entries by choosing .

For information on how to terminate or delete job assignments, see
Terminating/Deleting Job Assignments [Page 81].

Result
You have created one or more jobs.
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Assigning Jobs
Use
You assign jobs to positions so that the position inherits the characteristics of the job.

You can also assign a job to a task. For more information, see Assigning Tasks
[Page 113].

Prerequisites
You are familiar with Validity [Page 35]. Select a key date and preview period.

You have selected the staff assignments which include the position to which you want to assign
the job. For more information, see Displaying Objects [Page 44].

Procedure
1. Find a job that already exists. For more information, see Finding Objects [Page 41].

The job is displayed in the selection area.

2. Select this job in the selection area.

3. Holding down the left mouse button, drag the job to the Job column of the position in the Staff
assignments (List).

The job is assigned. To see the validity of the assignment, see Activating/Deactivating
Query Time Period [Page 39].

You can also assign a position to a job by entering the job on the Basic Data tab
page for the position. For more information, see Basic Data (Position) [Page 88].

4. Save your entries by choosing .

For information on how to terminate or delete job assignments, see
Terminating/Deleting Job Assignments [Page 81].

Result
You have assigned the job.
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Editing Jobs
Use
You can store numerous characteristics for each job used in Organizational Management and/or
other components.

You can create and edit further characteristics in Expert Mode [Ext.].

Prerequisites
You have already created a job [Page 76].

You are familiar with Validity [Page 35]. Select a key date and preview period.

Procedure
1. Select a job. For more information, see Finding Objects [Page 41] and Displaying Objects

[Page 44].

The characteristics of the job are displayed in the detail area.

2. Select a tab page in the detail area.

3. Make the appropriate entries.

4. Save your entries by choosing .
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Basic Data (Job)
Definition
The basic characteristics of a job.

Use
Basic data provides jobs with a unique identity. The characteristics of a job are inherited by the
positions which are created using the job as a basis.

Structure
• Short and long descriptions

In the two Job fields, enter a short and long description for an organizational unit. These
descriptions are displayed in the staff assignments and the job index, for example.

• Describing Texts
You can create various texts. Select a text type and enter a text.

Integration
The fields on this tab page are integrated with infotypes from the Organizational Management
Expert mode as follows:

• Short and long name: Object (infotype 1000) [Ext.]

• Describing texts: Description (infotype 1002) [Ext.]
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Terminating/Deleting Job Assignments
Use
You can:

• terminate a job assignment, if you no longer want the job to be assigned to a position

• delete the job, if you want to delete it completely, including its history

Prerequisites
Select the position for which you want to terminate/delete the assignment. For more information,
see Finding Objects [Page 41] and Displaying/Editing Objects [Page 44].

The position is displayed in the overview area.

Procedure
Terminating Job Assignment
3. In the selection area, double-click on the position whose assignment to a job you wish to

terminate.

The Task assignments appear in the overview area.

2. Select the job.

3. Choose  and then Assignment.

The Terminate Relationship dialog box appears.

5. Enter the date on which the job assignment is to be terminated.

The job assignment is terminated.

5. Save your entries by choosing .

Deleting Job Assignment
1. In the selection area, double-click on the position whose assignment to a job you wish to

delete.

The Task assignments appear in the overview area.

2. Select the job.

3. Choose  and then Assignment.

The job assignment is deleted.

4. Save your entries by choosing .
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Editing Staff Assignments
Use
Create Staff assignments [Page 18] for an organizational unit, so that you can specify

• which positions [Page 20] belong to the organizational unit

• which positions are occupied by which persons (employees) [Page 24] and users [Page 25].

• which positions are not occupied

Prerequisites
Staff assignments can only be created for organizational units that already exist.

Features
In the Organization and Staffing and the Organization and Staffing (Workflow) views, you can

• create staff assignments by creating positions

• display staff assignments or individual positions, persons (employees) or users

• assign positions, persons (employees) and users

• assign characteristics to positions
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Creating Positions
Use
You create positions to define the positions in an organizational unit that are to be occupied.

Prerequisites
You are familiar with Validity [Page 35]. Select a key date and preview period.

You have selected staff assignments. For more information, see Displaying Objects [Page 44].

Procedure
Creating Positions in the Staff Assignments (Structure)
1. In the selection area, double-click on the organizational unit that you want to assign the new

position to.

The organizational structure is displayed in the overview area.

2. Select the organizational unit to which you want to assign the new position.

3. Choose  and then Staff Assignment (Structure).

The Staff assignments (Structure) appear.

4. Choose :

The Select Relationship dialog box appears.

4. Select the object type Position and confirm your entry by choosing .

5. In the dialog box which appears, enter the period for which the position is to be valid in the
Valid from field.

7. Confirm your entry by choosing .

The new position is displayed in the staff assignments.

8. Replace the default short and long descriptions on the Basic Data tab page with names of
your choice.

For more information on editing characteristics, see Editing Positions [Page 87].

9. Save your entries by choosing .

For information on how to restrict the validity of your position or its assignments, see
Terminating/Deleting Positions or Assignments [Page 96].

Creating Positions in the Staff Assignments (List)
1. In the selection area, double-click on the organizational unit that you want to assign the new

position to.

The organizational structure is displayed in the overview area.

2. Select the organizational unit to which you want to assign the new position.
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3. Choose  and then Staff Assignment (List).

The Staff assignments (List) appear.

4. Choose :

5. In the dialog box which appears, enter the period for which the position is to be valid in the
Valid from field.

6. Confirm your entry by choosing .

The new position is displayed in the staff assignments.

7. Replace the default short and long descriptions on the Basic Data tab page with names of
your choice.

For more information on editing characteristics, see Editing Positions [Page 87].

8. Save your entries by choosing .

For information on how to restrict the validity of your position or its assignments, see
Terminating/Deleting Positions or Assignments [Page 96].

Result
The new position is created.

The position is valid from the key date entered in the detail area or from the key date that you
entered on the Basic Data tab page.

The organizational unit is assigned to the parent organizational unit from the key date entered in
the overview area.
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Assigning Positions
Use
To make changes to your company’s organizational structure, you can assign positions that
already exist to an organizational unit.

You can also assign other objects to a position. For more information, see Assigning
Objects [Page 50].

Prerequisites
You are familiar with Validity [Page 35]. Select a key date and preview period.

You have selected the staff assignments to which you want to assign a position. For more
information, see Displaying Objects [Page 44].

Procedure
1. Find a position, which already exists but which is not yet assigned to these staff assignments.

For more information, see Finding Objects [Page 41].

The position is displayed in the selection area.

2. Select this position in the selection area.

3. Holding down the left mouse button, drag the position to free area of the staff assignments.

The position is assigned to the staff assignments and the organizational unit. To see the
validity of the assignment, see Activating/Deactivating Query Time Period [Page 39].

4. Save your entries by choosing .

For information on how to restrict the validity of an assignment, see
Terminating/Deleting Positions or Assignments [Page 96].

Result
You have assigned the position.
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Editing Positions
Use
You can store numerous characteristics for each position used in Organizational Management
and/or other components.

Prerequisites
You have already created a position [Page 84].

You are familiar with Validity [Page 35]. Select a key date and preview period.

Procedure
1. Select a position. For more information, see Finding Objects [Page 41] and Displaying

Objects [Page 44].

The staff assignments concerned are displayed in the overview area, the characteristics
of the position are displayed in the detail area.

2. Select a tab page in the detail area.

3. Make the appropriate entries.

4. Save your entries by choosing .
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Basic Data (Position)
Definition
The basic characteristics of a position.

Use
Basic data provides positions with a unique identity. It also provides you with information on your
enterprise’s staffing status.

Structure
• Short and long descriptions

In the two Position fields, enter a short and long description for a position. These
descriptions are displayed in the staff assignments, for example.

• Job
The job assigned to the position is displayed in the Job field. You can assign a job
directly by entering its name here. Otherwise, you assign a job to a position in the staff
assignments. For more information, see Assigning Jobs [Page 77].

• Chief of Organizational Unit
By flagging this field, you mark a position as the chief position of the organizational unit
to which it belongs.

You can also flag a chief position of an organizational unit on the Chief+Account
Assignment [Page 66] tab page.

Chief positions are evaluated in SAP Business Workflow. For more information, see Role
for Determining a Manager [Ext.].

• Staffing Status
You can enter the following statuses in this field:

Vacancy open – the position is vacant, that is, a person (employee) is to be found for the
position. The position is marked as vacant in Recruitment.

Vacancy occupied or put on hold – the position was vacant, however, no person is to be
found for the position at the present time.

Obsolete – the position will no longer be required in the future-.

For more information, see Position [Page 20].

• Staff
By choosing the Staff field, you can assign a staff indicator to positions. A staff flag
indicates that a position is not part of the normal reporting structure at your company, but
rather reports directly to a high level position, or organizational unit. In this way, a
position can report directly to the chief executive officer.

• Holder
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Persons (employees) and users who occupy the corresponding positions are displayed
in the Holder table

• Describing Text
You can create various texts. Select a text type and enter a text.

Integration
The fields on this tab page are integrated with infotypes from the Organizational Management
Expert Mode [Ext.] as follows:

Short and long text: Object (infotype 1000) [Ext.]

Job: Relationship (infotype 1001) [Ext.]

Chief of an organizational unit: Relationship (infotype 1001) [Ext.]

Staffing status: Vacancy (infotype 1007) [Ext.] and Obsolete (infotype 1014) [Ext.]

Staff: Department/Staff (infotype 1003) [Ext.]

Holder: Relationship (infotype 1001) [Ext.]

Describing text: Description (infotype 1002) [Ext.]
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Account Assignment (Position)
Definition
Specification of a controlling area, master cost center, company code, business area, personnel
area and personnel subarea for a position.

Use
You specify the account assignment features of a position. If account assignment features have
been specified for a superior organizational unit, these are overwritten by entries on the Account
Assignment tab page for a position.

The Account Assignment tab page is not available in the Organization and Staffing (Workflow)
view.

Structure
• Controlling Area

The controlling area assigned to the position is displayed.

• Cost Center
You can assign a master cost center to a position. This forms the basis for Cost
Distribution [Page 94].

• Company Code
You can assign a company code to a position.

• Business Area
You can assign a business area to a position.

• Personnel Area
You can assign a personnel area to a position.

• Personnel Subarea
You can assign a personnel subarea to a position.

Integration
Data on the controlling area, company code, business area, personnel area and personnel
subarea are used as default values in Personnel Administration.

Data on the cost center is transferred to Personnel Administration in infotype 0001.

The fields on this tab page are integrated with infotypes from the Organizational Management
Expert Mode [Ext.] as follows:

• Controlling area: About the Account Assignment Features Infotype (1008) [Ext.]

• Master cost center: Relationship (infotype 1001) [Ext.]

• Company code: About the Account Assignment Features Infotype (1008) [Ext.]

• Business area: About the Account Assignment Features Infotype (1008) [Ext.]
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• Personnel area: About the Account Assignment Features Infotype (1008) [Ext.]

• Personnel subarea: About the Account Assignment Features Infotype (1008) [Ext.]



Organizational Plan Mode  SAP AG

Address (Position)

92 December 1999

Address (Position)
Definition
Specification of a first or second address for a position.

Use
You can enter detailed information on the specific physical location of a position.

Structure
The first or second address for a position contains the following:

• Building
You can enter the specific building for which an address is stored.

• Address supplement
You can enter an address supplement, for example a postal code or c/o address.

• Street/house number
You can enter the street and house number as a part of the address.

• Town
You can enter the name of the town or city

• Postal code
You can enter the postal code for the address.

• Country
You can enter a key which represents a particular country.

• Region
You can enter the name of the region (or the name of a state, county or province etc.) if it
is relevant to the address in a particular country. This is country-specific.

• Telephone number
You can enter the telephone number of the position.

• Fax number
You can enter the fax number of the position.

• E mail address
You can enter the e mail address of the position.

Integration
The fields on this tab page are integrated with Infotype 1028 [Ext.] from the Expert Mode [Ext.] of
Organizational Management.
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Cost Distribution (Position)
Definition
Distribution of costs arising to several cost centers.

Use
Costs incurred by a position are usually written to the cost center directly assigned to the position
(master cost center) or the cost center inherited by the organizational unit. For more information,
see Account Assignment (Position) [Page 90].

Create a cost distribution if you wish to distribute costs to more than one cost center. Enter which
portion of the costs you would like to distribute to which cost center. If the position is already
assigned a master cost center, the left-over share will be written to this cost center.

If the position was assigned a master cost center before it was created, you must
reconcile cost distribution with this.

You will find the Cost Distribution tab page in the Organization and Staffing (Workflow) view.

Structure
In the table which is displayed, you can enter the percentage of costs that is to be distributed to
each cost center. You can also assign orders and WBS elements.

Integration
The fields on this tab page are integrated with Infotype 1018 [Ext.] from the Expert Mode [Ext.] of
Organizational Management.
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Working Time (Position)
Definition
The time which is to be worked by persons (employees) or users that occupy the corresponding
position.

Use
You specify the planned working time for the persons (employees) or users for this position.

You will find the Working Time tab page in the Organization and Staffing (Workflow) view.

Structure
• Employee group

You assign an employee group to the position.

• Employee subgroup
You assign an employee subgroup to the position.

• Origin
Enter the origins of the work schedule in this field. If the work schedule comes from the
rule value definition in Customizing, enter Standard Entry. If the work schedule has been
inherited from a superior organizational unit, the name of the organizational unit is
displayed.

• Work schedule
Working times are entered in this field.

• Approval
The entry in this field specifies the percentage of the work schedule corresponds to the
planned working time.

For more information (particularly on inheritance), see Work Schedules [Ext.].

Integration
The fields on this tab page are integrated with infotypes from the Organizational Management
Expert Mode [Ext.] as follows:

• Employee group/subgroup: Employee Group/Subgroup (infotype 1013) [Ext.]

• Work schedule: Work Schedule (infotype 1011) [Ext.]
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Terminating/Deleting Positions or Assignments
Use
You can:

• terminate a position, if you want to limit the validity of the position (the current assignment is
also deleted)

• terminate the assignment of a position, if the position is no longer to be assigned

• delete a position, if you want to delete it completely, including its history

Prerequisites
You are in the Staff assignments (Structure). For more information, see Finding Objects [Page
41] and Displaying/Editing Objects [Page 44].

Procedure
Terminating Positions or Assignments
4. Select a position.

5. Choose

−  and then Object, if you want to terminate the validity of the position

−  and then Assignment, if you want to terminate the assignment of the position to a
superior organizational unit

In the first case, the Terminate on dialog box appears, in the second, the Terminate
relationship dialog box.

6. Enter the date on which the position or assignment is to be terminated.

7. Confirm your entries by choosing .

6. Save your entries by choosing .

The position or assignment is terminated.

Deleting Positions or Assignments
4. Select a position.

5. Choose

−  and then Object, if you want to delete the position

−  and then Assignment, if you want to delete the assignment of the position to a
superior organizational unit

The position or assignment is deleted.

6. Save your entries by choosing .
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Assigning Persons/Users
Use
You assign a person (employee) or user to a position so that you can define who occupies
positions in your enterprise. More than one person (employee) and/or user may occupy a
position.

You can also a person (employee) or a user to a task. For more information, see
Assigning Tasks [Page 113].

Prerequisites
Persons (employees) or users, which you want to assign to a position must already have been
created.

You are familiar with Validity [Page 35]. Select a key date and preview period.

You have selected the staff assignments which include the position to which you want to assign a
person (employee) or user. For more information, see Displaying Objects [Page 44].

Procedure
1. You are in the staff assignments. The position to which you want to assign the person

(employee) or user is displayed.

2. Find the person (employee) or user that you want to assign. For more information, see
Finding Objects [Page 41].

The person or user is displayed in the selection area.

3. Select the person or user from the selection area.

4. With the left mouse button held down, drag the person or user to the position displayed in the
staff assignments.

Alternatively, you can drag the person (employee) or user to the Holder field on the
Basic data tab page for the position in the detail area.

The Assign Persons or Assign Users dialog box appears.

5. Enter a validity period for the assignment and select a personnel action.

If the person (employee) or user already holds a position, you can specify that this
previous assignment is to continue to exist by selecting the Additional occupancy field.

Otherwise, you can specify that this assignment is to be terminated (that is the person or
user is to be transferred to the new position) by flagging the Transfer field.

6. Confirm your entries by choosing .

If you are transferring a person (employee) or user, the Create vacancy dialog box
appears. Specify until when the current position is to be occupied. Confirm your
requirements with Yes or No.
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If the new position was vacant, the Delimit vacancy dialog box appears. Specify if and
when this position is to be delimited. Confirm your requirements with Yes or No.

7. Save your entries by choosing .

The person (employee) or user is assigned to the position from the date entered.

Result
You have assigned the person to the position.
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Terminating/Deleting Person/User Assignments
Use
You can

• terminate the assignment of a person (employee) or user to a position, if the person or user
is no longer to be assigned

• delete the assignment of a person (employee) or user to a position if you want to delete the
assignment.

Prerequisites
You are in the Staff assignments (Structure). For more information, see Finding Objects [Page
41] and Displaying/Editing Objects [Page 44].

Procedure
Terminating Assignment
6. Select the a person (employee) or user.

4. Choose  and then Assignment.

The Terminate Relationship dialog box appears.

8. Enter the date on which the position or assignment is to be terminated.

6. Confirm your entries by choosing .

The Create Vacancy dialog box appears.

You can create a vacancy for the position and enter a validity start date for the vacancy.

5. Choose Yes, No or Cancel.

The assignment is terminated.

If a position is not occupied and you select a field from the Person/User column
using the right mouse button, the menu path Terminate → Object appears. You can
use this to terminate the validity of the position.

Delete Assignment
1. Select the a person (employee) or user.

4. Choose  and then Assignment.

The Create Vacancy dialog box appears.

You can create a vacancy for the position and enter a validity start date for the vacancy.

3. Choose Yes, No or Cancel.

The assignment is deleted.
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Displaying/Editing Personal Data
Use
Numerous characteristics are stored for persons (employees) and users in Personnel
Administration and Personnel Development. You can display some characteristics in
Organizational Management. You can also assign tasks and positions.

Prerequisites
The characteristics of a person (employee) are stored in Personnel Administration or Personnel
Development.

You are familiar with Validity [Page 35]. Select a key date and preview period.

Procedure
1. Select a person (employee). For more information, see Finding Objects [Page 41] and

Displaying Objects [Page 44].

The characteristics of the person (employee) are displayed in the detail area.

2. Select a tab page in the detail area.

3. Make the appropriate entries.

4. Save your entries by choosing .
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Basic Data (Person)
Definition
The basic characteristics of a person (employee).

Use
Entering basic data can provide a person (employee) with a unique organizational assignment.

Structure
The Position assignment table on the Basic data tab page contains the following data on the
organizational assignment of a person:

• Position
This column of the table displays the position or positions to which the person
(employee) is assigned. You can use Drag & Drop to assign positions. For more
information, see Assigning Persons/Users [Page 98].

• Job
The job on which the position is based is displayed in this column of the table.

• Position ID
The ID of the position which the person (employee) occupies is displayed in this column.

• Organizational unit
This column contains the organizational unit to which the position that the person
(employee) occupies is assigned.

• Percentage
This column contains the staffing percentage of the position, that is the percentage of his
or her working time the person (employee) occupies the position.

• Valid from
This column contains the start date of the assignment of the person (employee) to the
position.

• Valid to
This column contains the end date of the assignment of the person (employee) to the
position.

Integration
The Position assignment table is integrated with Infotype 1001 [Ext.] from the Organizational
Management Expert Mode [Ext.].
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Qualifications (Person)
Definition
A person (employee)’s qualifications.

Use
Provides information on a person (employee)’s qualifications.

The Qualifications tab page is not available in the Organization and Staffing (Workflow) view.

Structure
The qualifications and additional information are displayed in the table.

Integration
The data displayed comes from the Personnel Administration component.
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Displaying/Editing User Data
Use
Numerous characteristics are stored for users in User Maintenance. You can display some of
these characteristics in Organizational Management. You can also assign tasks and positions.

Prerequisites
Characteristics for a user have been created in User Maintenance.

You are familiar with Validity [Page 35]. Select a key date and preview period.

Procedure
5. Select a user. For more information, see Finding Objects [Page 41] and Displaying Objects

[Page 44].

The characteristics of the user you selected are displayed in the detail area.

6. Select a tab page in the detail area.

7. Make the appropriate entries.

8. Save your entries by choosing .
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Basic Data (User)
Definition
The basic characteristics of a user.

Use
Using basic data, a user can be provided with a unique organizational assignment.

Structure
The Position assignment table on the Basic data tab page contains the following data on the
organizational assignment of a user:

• Position
This column of the table displays the position or positions to which the user is assigned.
You can use Drag & Drop to assign positions. For more information, see Assigning
Persons/Users [Page 98].

• Job
The job on which the position is based is displayed in this column of the table.

• Position ID
The ID of the position which the user occupies is displayed in this column.

• Organizational unit
This column contains the organizational unit to which the position that the user occupies
is assigned.

• Percentage
This column contains the staffing percentage of the position, that is the percentage of his
or her working time the user occupies the position.

• Valid from
This column contains the start date of the assignment of the user to the position.

• Valid to
This column contains the end date of the assignment of the user to the position.

Integration
The Position assignment table is integrated with Infotype 1001 [Ext.] from the Organizational
Management Expert Mode [Ext.].
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Editing Tasks
Use
You create Tasks [Page 26],

• to describe your organizational objects

• so that SAP Business Workflow [Ext.] relevant tasks are forwarded to the correct agent.

Features
You can:

• Create tasks

• Assign tasks

• Display tasks

• Assign characteristics to tasks
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Creating Tasks
Use
You create tasks so that you can assign them to other organizational objects.

Prerequisites
• Check whether a suitable task exists already, so that you can avoid creating a new task:

Select one or more of the existing tasks from using the search area. For more information,
see Finding Objects [Page 41] and Displaying Objects [Page 44].

You can display data on the task you have selected in the detail area.

• You are familiar with Validity [Page 35].

• Before you create a new task, you must have specified which organizational object you want
to assign the new task to.

Procedure
The procedure for creating a task varies according to the organizational object you want to
assign the task to.

Creating Tasks (Job/Position)
3. In the selection area, double-click on the job/position that you want to assign the new task to.

The job/position is displayed in the overview area and the characteristics of the
job/position are displayed in the detail area.

4. Select a job/position from the overview area.

5. Choose :

The Select Relationship dialog box appears.

5. Select the object type Task and confirm your entry by choosing .

8. In the dialog box which appears, enter the period for which the task is to be valid in the Valid
from field.

9. Confirm your entry by choosing .

The task is created and assigned to the relevant job/position.

10. In the detail area, you can enter a short name for the task in the Object abbreviation field.
You can enter a long name in the Name field.

11. Save your entries by choosing .

Creating Tasks (Organizational Unit)
1. In the selection area, double-click on the organizational unit that you want to assign the new

task to.

The organizational structure for the organizational unit concerned appears.

2. In the overview area, select the organizational unit to which you want to assign the new task.
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3. Choose  and then Task assignment.

The tasks assigned to the organizational unit are displayed.

4. Choose :

The Select Relationship dialog box appears.

5. Select the object type Task and confirm your entry by choosing .

6. In the dialog box which appears, enter the period for which the task is to be valid in the Valid
from field.

7. Confirm your entries by choosing .

The task is created and assigned to the relevant position.

8. In the detail area, you can enter a short name for the task in the Object abbreviation field.
You can enter a long name in the Name field.

9. Save your entries by choosing .

Creating Tasks (Person/User)
1. In the selection area, double-click on the person (employee) or user to which you want to

assign the new task.

The Organizational assignment appears in the overview area.

2. Select the a person (employee) or user from the overview area.

3. Choose  and then Task assignment.

The Task assignments appear.

4. Select the a person (employee) or user and choose .

The Select Relationship dialog box appears.

5. Select the object type Task and confirm your entry by choosing .

6. In the dialog box which appears, enter the period for which the task is to be valid in the Valid
from field.

7. Confirm your entries by choosing .

The task is created and assigned to the relevant person (employee) or user.

8. In the detail area, you can enter a short name for the task in the Object abbreviation field.
You can enter a long name in the Name field.

9. Save your entries by choosing .

For information on how to terminate or delete task assignments, see
Terminating/Deleting Task Assignments [Page 119].

Result
You have created one or more tasks.
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Assigning Tasks
Use
You assign tasks to organizational objects (organizational units, positions, jobs, persons
(employees) or users),

• to describe the activities that they have to perform

• so that SAP Business Workflow relevant tasks are forwarded to the correct agent

Prerequisites
You are familiar with Validity [Page 35]. Select a key date and preview period.

Procedure
You can either assign tasks to objects or objects to tasks. The results will be identical.

Assigning an Object to a Task
1. Select a task. For more information, see Finding Objects [Page 41] and Displaying/Editing

Objects [Page 44].

2. Double-click on the task in the selection area.

The task is displayed in the overview area.

3. Choose  and then Agent.

The objects that are already assigned to the task are displayed.

4. Search for an object that you want to assign to the task. For more information, see Finding
Objects [Page 41].

5. The object is displayed in the selection area.

6. Select this object in the selection area.

7. Holding down the left mouse button, drag the object to the task in the overview area.

The task is assigned to the object. For more information on the validity of the
assignment, see Activating/Deactivating Query Time Period [Page 39].

8. Save your entries by choosing .

Assigning a Task to an Object
You assign a task to an object in the Task assignments in the overview area. If you are not in the
Task assignments, choose  → Task assignment.

1. The object is displayed in the overview area.

2. Select a task. For more information, see Finding Objects [Page 41].

The task is displayed in the selection area.

3. Holding down the left mouse button, drag the task to the object in the overview area.
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The object is assigned to the task. To see the validity of the assignment, see
Activating/Deactivating Query Time Period [Page 39].

4. Save your entries by choosing .

For information on how to terminate or delete task assignments, see
Terminating/Deleting Task Assignments [Page 119].
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Editing Tasks
Use
You can store basic data for a task which you can use to describe the task more clearly.

You can create and edit further characteristics in Expert Mode [Ext.].

Prerequisites
You have already created a task [Page 110].

You are familiar with Validity [Page 35]. Select a key date and preview period.

Procedure
1. Select a task. For more information, see Finding Objects [Page 41] and Displaying Objects

[Page 44].

The characteristics of the task are displayed in the detail area.

5. Select a tab page in the detail area.

6. Make the appropriate entries.

7. Save your entries by choosing .
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Name
Definition
The basic characteristics of a task.

Use
You can identify a task by making entries on the Name tab page. You can also translate the short
and long names of the task.

The tab page is not available for  Standard tasks,  Workflow templates and  Task groups
in the Organization and Staffing (Workflow) view.

Structure
• Planning status

In this field, you can specify the planning status of the task in the planning cycle.

• Language
The logon language is displayed here, if it has been maintained. You can overwrite the
long and short names by choosing . Via Maintain translation, you can translate the
short and long names into another language and thus create various language-versions
of your task.

• Object abbreviations
You can overwrite the short name for your task.

• Name
You can overwrite the long name for your task.

Integration
The fields on this tab page are integrated with Infotype 1000 [Ext.] from the Expert Mode [Ext.] of
Organizational Management.
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Description
Definition
Description of a task.

Use
The Description tab page provides you with a description of a task.

The tab page is not available for  Standard tasks,  Workflow templates and  Task groups.

Structure
• Planning status

In this field, you can specify the planning status of the task in the planning cycle.

• Language
The description of the task in the logon language is displayed here, if it has been
maintained.

• Subtype

If you choose  , possible entries appear to aid you in your selection of a text type in
which you can enter a text. If you choose Maintain translation, you can create the text in
another language. The original validity period is used for this function.

Integration
The fields on this tab page are integrated with Infotype 1002 [Ext.] from the Expert Mode [Ext.] of
Organizational Management.
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Basic Data
Definition
The basic characteristics of a task relevant to workflow.

Use
The entries you make on the Basic data tab page enable tasks to be forwarded to the relevant
agent for execution in SAP Business Workflow [Ext.] .

This tab page is not available for  Tasks in the Organization and Staffing view.

Structure
− General Task

If you set this indicator, you specify that all users can carry out this task in Workflow.

− General forwarding not Allowed
Using this indicator, you specify that these tasks may only be forwarded to certain
users who are the agents of these tasks. If this indicator is not set, this task may be
forwarded to all users.

For more information on using these two indicators in SAP Business Workflow, see
Agent Assignment Maintenance [Ext.].

− Locked Against Execution
Specifies that a work item for this task or this workflow process has been created but
can not be executed.

− Locked For Instantiation
Specifies that no work item has been created for this workflow process or task.

For more information on using these two indicators in SAP Business Workflow, see
Classification and Lock Indicator Maintenance [Ext.].

− Classification
Tasks can be classified as professional, personal or disciplinary, however, you do
not have to assign them to a class.

For more information on using this indicator in SAP Business Workflow, see
Classification and Lock Indicator Maintenance [Ext.].

− Release Status
Using this indicator, you specify the status of a task. You can specify whether a task
is to be generally released or implemented or whether it is obsolete.
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Terminating/Deleting Task Assignment
Use
You can:

• terminate a task assignment, if you no longer want a task to be assigned to an organizational
unit.

• delete the task assignment, if you want to delete it completely, including its history

Prerequisites
In the selection area, select the task whose assignment to another organizational object you wish
to terminate/delete.

Procedure
Terminating Task Assignment
7. Double-click on the task in the selection area.

The task is displayed in the overview area, the characteristics of the task are displayed in
the detail area.

5. Select the task in the overview area.

6. Choose  and then Task usage.

7. Select the object whose assignment to the task you wish to terminate.

8. Choose  and then Assignment.

The Terminate Relationship dialog box appears.

9. Enter the date on which the task assignment is to be terminated.

10. Confirm your entries by choosing .

The task assignment is terminated.

Deleting Task Assignments
2. Repeat steps 1 to 3 above.

5. Select the object whose assignment to the task you wish to delete.

3. Choose  and then Assignment.

The task assignment is deleted.

4. Save your entries by choosing .
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General Structures
Use
As well as the standard object types used in Organizational Management, you can ínclude
objects types, which you have defined yourself (teams, for example) in the structure.

This function is used, for example, when editing dimensions within the Matrix Organization [Page
123]. See also Structure Maintenance [Page 134]

Prerequisites
To be able to edit and display functions, you must do the following in the initial screen

• determine the object type of the start object

• enter the object ID and abbreviation of the start object

• enter an evaluation path

When you enter a start object and evaluation path, a structure appears, in which you can
edit and display objects or relationships as well as create new objects and relationships.

Evaluation paths determine the objects and relationships that are to be edited or
displayed as well as the new objects and relationships that may be created.

You may only edit and display objects and relationships beneath the start object in the
hierarchy that are included in the evaluation path. This also applies to the creation of new
objects and relationships.

Features
Creating Structures
You create the root object by entering an object type, abbreviation and name. From this root
object, you can add subordinate objects and relationships to the structure. By entering an
evaluation path, you specify the objects and relationships you wish to include in the structure.

Editing Structures
You can edit structures, which already exist, that is, you can delimit, move or delete objects from
the structure as well as create new objects in the structure. You may also create, delimit and
delete relationships. Via Goto → Object Description you can also maintain infotypes for individual
objects.

If you want to create object or relationship, a dialog box appears, which displays the objects and
relationships you may create. The system determines this selection based on the evaluation
paths, which you entered.

You can display the evaluation path you have selected by choosing Goto. Icons indicate which
relationships may be edited and which may only be displayed.

You can also select a new evaluation path.
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Displaying Structures
By entering a start object and evaluation path, you specify which structures, that is, which objects
and relationships you wish to display.
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Matrix Organization
Definition
The matrix organization represents a two-dimensional hierarchy. This is based on positions
reporting to more than one superior organizational object.

Use
Using the matrix organization tool, you can distribute limited resources across multiple
organizational structures.

In a plant you may have a maintenance crew that is multi-talented, and thus not
restricted to working in a specific work center. The pipe fitter in the crew reports to
the manager of the work center where he fits pipes (functional reporting). He also
reports to his own line manager (line reporting).

Structure
In a matrix organization, a vertical structure combines with a horizontal structure, that is two
divisions overlap on the same hierarchical level. Here, the principles of functional reporting and
line reporting intersect. The points of intersection represent positions which perform tasks for
both the horizontal and vertical line.

Different variations on the horizontal and vertical systems result in different appearances of the
matrix organization, for example:

• Project Matrix Organization

• Team Matrix Organization

• Product Matrix Organization

• Matrix in Connection with Legally Autonomous Units

• Matrix for Applicant Selection Procedure

Integration
Matrix organizations co-exist with hierarchical organizations. You use organizational objects to
display different views within a matrix organization. You choose the views that are relevant to
your business processes.

See also:
Maintaining Matrix Organizations [Page 124]
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Maintaining Matrix Organizations
Use
Organizational structures, such as traditional organizational hierarchies, often focus too much on
departmental objectives. This can sometimes be to the detriment of the objectives of the
enterprise itself.

The matrix organization can solve this problem by assigning specific tasks for a specific purpose.
It gives rise to units with different tasks that can make decisions to fulfill the tasks without, for
example, having to turn to the management of the enterprise.

Features
Using the matrix tool, you can create different types of matrix organizations.

Project Matrix Organization
The objective of this organizational type is to use project groups to process new and fixed-term
tasks for more than one area. Projects integrate employees from different areas within the
enterprise for all, or part, of the time.

Unlike team work, project work describes alternating groups of employees who work together in
special areas. The project employees do not have to originate from a single group of employees.

The employees of an organizational unit are subordinate to the line manager with regard to
disciplinary matters, and to the project manager with regard to subject matter.

When project reporting is carried out, the most important question is who belongs to a project.
An employee can belong in part to a project. His or her position does not, therefore, have to be
assigned 100% to a project.

Team Matrix Organization
A team organization is used to carry out more complex projects at an enterprise. It includes
several areas, and requires a wide range of specialized knowledge.

A team is characterized by far-reaching task orientation, and autonomy with regard to the
methods used to fulfill the task.

Teams exist for a fixed term. When assigned to a team, employees are released from their staff
and line tasks. Their competencies, tasks, and assignment within the organization are based
purely on the requirements of the team.

Team work often constitutes a considerable part of a work group. Unlike project work, team work
is characterized by a continuous exchange of information, being the main responsibility of each
individual employee.

When team reporting is carried out, all employees and positions assigned to a team are
evaluated. A position is assigned 100% to just one team. The employees can originate from
different areas, so they are assigned to different organizational units.

Product Matrix Organization
Matrix organizations are often used in production environments, and enterprises that
manufacture and distribute a variety of products.
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An example of this type of matrix organization is a car manufacturer that is divided into the sales
and distribution, financial accounting, and production departments. The company manufactures a
variety of products, namely Model 1, Model 2, Model 3, and so on.

In a matrix organization, a Salesperson position reports to the Sales and Distribution department,
and to the Model 1 group or department.

When product reporting is carried out, all of the Salesperson positions are evaluated, for
example, that are assigned to Model 1, Model 2, Model 3, and so on.

Matrix in Connection with Legally Autonomous Units
These matrix organizations are not restricted to Organizational Management objects only. For
example, organizational units such as the Executive Board, Sales and Distribution, and
Development can be placed on the vertical level. At the same time, legally autonomous units
such as SAP Holding, SAP Germany, and SAP USA can be placed on the horizontal level.
Existing assignments between these dimensions are then highlighted at the points of intersection
within the matrix, and the relationship period is displayed.

The predefined matrix type supplied by SAP is called legal classification. Its short
form is legal. In the matrix view, the organizational units (object type O) are assigned
in the vertical dimension, and the legally autonomous units (OR) are assigned in the
horizontal dimension. The matrix relationship is: organizational unit is assigned to
(B 401).

Matrix for Applicant Selection Procedure
The following matrix organization can be used, for example, to simplify applicant selection. You
can use a matrix in which:

• Applicant groups are created using applicants

• Appraisal teams are created using employees

• Applicant groups are assigned to appraisal teams

Activities
The Simple Maintenance function in Organizational Management enables you to process not
only hierarchical, but also matrix and other complex organizational structures.

When you maintain a matrix, these are the activities you perform:

• Customizing matrix types

• Accessing matrix maintenance

• Matrix processing

− Matrix view processing

− Structure view processing

• Maintaining the structure

See also:
Accessing Matrix Maintenance [Page 127]
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Accessing Matrix Maintenance
Use
You can perform matrix processing activities by accessing the Simple Maintenance function. On
the Organizational Management screen, choose Simple Maintenance → Matrix → Change or
Display. The Access Matrix Organization dialog box appears.

Activities
This screen enables you to access matrix maintenance in one of three ways:

• Choose a predefined matrix type

• Specify a matrix view as a variant

• Determine a matrix view using standard selection

If you use the first method, you choose the matrix type that you require from the predefined
matrix types and then start matrix processing. You choose only the root object for all horizontal
and vertical objects. The required relationship between the dimensions is predetermined by your
choice of matrix type, as are the object types and the evaluation path of both dimensions.

You can choose standard matrix types or define them yourself in Customizing. If you
define matrix types, you can use object types and objects that exist for this purpose.
You can also set up new object types, objects, and relationships in Customizing.

If you use the second method, you specify the name of the matrix view with which you previously
worked, and which you then saved as a variant. This determines the root object for all horizontal
and vertical objects, as well as the required matrix relationship. This facilitates direct access of
matrix processing. You might want to use a variant if, for example, you frequently work with the
same matrix view.

If you use the third method, you can determine the required matrix view yourself. You access a
selection screen in which you enter the required root object type, and the root object, for both
dimensions, as well as the relationship between the dimensions. You can also specify an
evaluation path for each dimension, which enables you to determine the objects that can be
displayed in the matrix and hierarchy view.

See also:
Customizing Matrix Types [Page 133]

Matrix Processing [Page 128]
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Matrix Processing
Use
Matrix processing enables you to maintain the matrix assignments. These are the relationships
required between the objects of dimension 1, and the objects of dimension 2.

You can process the matrix in the:

• Matrix view

• Structure view

Here, dimensions are displayed in a tree structure.

Prerequisites
To process a matrix, the following must be done:

• The types of organizational object that can be combined in matrix processing must be
determined. To do this, define the matrix type in Customizing. You cannot define the matrix
type until you have defined the object types, which you also do in Customizing.

• The type of relationship required between the object type of dimension 1, and the object type
of dimension 2, must be specified. The relationship type is specified automatically by
choosing the matrix type, or by you specifying the one you require on the standard selection
screen.

• The root object must be specified for all horizontal and vertical objects. If no root object is
specified, all objects of the object type are selected.

1. By specifying an evaluation path for the horizontal and vertical dimension,
you also determine the objects that can be displayed in the matrix and
hierarchy view.

2. Within the hierarchy view, you can display the evaluation path by choosing
Goto → Display evaluation path. The Display Evaluation Path dialog box
contains indicators that show whether a matrix relationship can be
maintained (pencil) or displayed (glasses).

See also:
Matrix View Processing [Page 129]

View Options in Matrix View Processing [Page 130]

Structure View Processing [Page 131]

View Options in Structure View Processing [Page 132]
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Matrix View Processing
Use
In the matrix view, the relationships that you set up between the two dimensions are highlighted
within the matrix at the points of intersection. Relationship and delimitation dates are also
displayed for further information.

Activities
Starting from the Access Matrix screen, you can access the Matrix View / Change or Display
screen by choosing one of the three buttons, on this screen you can edit the matrix in the
following ways:

Maintaining Matrix Assignments
On the Matrix View / Change screen, you maintain matrix assignments by choosing one of the
points where the two lines meet and choosing Matrix assignment → Create or Delete or Delete or
via Create, Delimit or Delete. You can perform the following maintenance activities:

• Create matrix assignments

• Delimit matrix assignments

• Delete matrix assignments

The validity period specified on the Access Matrix screen is also used as the
selection period for the assignment. This period is also the default on the Matrix
View/Change screen when you create an assignment.

Printing the Matrix View Screen
To print out the matrix view screen, choose Matrix assignment → Print. To display the
assignment period in the printing screen, choose View → Relationship period on.

See also:
View Options in Matrix View Processing [Page 130]

Structure View Processing [Page 131]
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View Options in the Matrix View
Selecting view options

To: Choose:

Invert dimensions View → Invert dimensions, or

Invert dimensions

Update the structure Edit → Update, or

Update

Change the view View →=Structure → Dimension 1 or Dimension 2,

If you choose Structure, the system defaults to the Structure Dimension 1: Change
screen. Once you have accessed the Structure Dimension 1: Change screen, you
can also view structure dimension 2 by choosing Invert dimension.

See also:
Matrix View Processing [Page 129]
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Structure View Processing
Use
You can use the hierarchy view to display the structure of a dimension in a tree structure
(together with its objects), the relationships to the second dimension, and the entire structure of
the second dimension.

You can also use the structure view, as well as the matrix view, to maintain matrix assignment.

Activities
On the Access Matrix screen, choose one of the following screens, which enable you to perform
a number of matrix processing activities in the structure view:

• Structure Dimension 1:

• Structure Dimension 2

Maintaining Matrix Assignments
You maintain matrix assignments by choosing the name of an object and performing the
following maintenance activities by choosing Matrix assignment → Create or Delimit or Delete or
via Create, Delimit or Delete:

• Create matrix assignments

• Delimit matrix assignments

• Delete matrix assignments

To display the change within your structure, choose Edit → Update, or alternatively,
choose Update directly.

See also:
View Options in Structure View Processing [Page 132]

Matrix View Processing [Page 129]
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View Options in Structure View Processing
Selecting View Options

To: Select:

Invert dimensions

(Display and edit the tree structure, starting with the root
object of the other dimension and all of its underlying
objects)

View → Invert dimensions, or

Invert dimensions

Expand and compress the tree structure Expand or Compress

Change the view View → Matrix view, or

Matrix view.

See also:
Structure View Processing [Page 131]
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Customizing Matrix Types
Use
The matrix types must be defined before you can access matrix processing by choosing matrix
types You must use Customizing to determine the types of objects within the system that can be
combined.

You can assign object types from Organizational Management, such as organizational units and
positions, as well as external objects, such as plants and customers.

Prerequisites
To use Customizing to determine matrix types, you must first use Customizing to create object
types, objects, and relationships between object types.

The matrix type definition determines the sequence of object types within the matrix, which
entails a kind of preselection of the possible views. You determine the:

• Objects that are displayed horizontally within the matrix view

• Objects that are displayed vertically in the matrix view

• Type of assignment that can be maintained between these objects

Evaluation Paths
An evaluation path describes a chain of relationships between objects in a hierarchical structure.
The O-S-P evaluation path, for example, describes the organizational unit - position - person
relationship chain. The system evaluates the structure of your organizational plan along this
evaluation path.

Customizing enables you to specify an evaluation path for each dimension, and to determine the
structure that can be displayed within the matrix and hierarchy view.

See also:
Accessing Matrix Maintenance [Page 127]
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Maintaining the Structure
Use
You can maintain objects within the structure of your two dimensions, without accessing the
matrix and hierarchy view. This can be necessary, for example, to take account of structural
changes in the dimensions of your matrix organization.

Activities
Starting from the matrix view or hierarchy view, you can access the Dimension 1: Change, or
Dimension 2: Change, screens by choosing Goto → Dimension maintenance → Dimension 1, or
Dimension 2.

You can only set up matrix assignments in the matrix or hierarchy view.

The Edit menu option and functions in the standard toolbar enable you to:

1. Create objects

– Delimit objects

– Move objects

– Delete objects

2. Create relationships

– Delimit relationships

– Delete relationships

You can only maintain the objects and relationships that are included in the
evaluation path you specified for a dimension. If you do not specify an evaluation
path, you can only create individual root objects.

See also:
Matrix Processing [Page 128]
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Reports in Organizational Management
Use
The Organizational Management component offers numerous reports, with which you can access
data on your most important questions concerning the organizational plan.

Features
When you access a report, a screen containing selection parameters appears. As well as
report-specific parameters, additional selection fields are provided:

• <Object type> (depending on report: organizational unit, job, position, work center or task)

You can specify the object with which you want to start the report.

• Search Term
You can search for an object.

• Status
You can specify that only objects with a certain status can be reported on.

• Reporting Period / Reporting Key Date
Depending on the report, there are various criteria for determining a key date or a
reporting period.

You can switch to the standard selection screen in many reports that you access via the SAP
menu. This offers additional selection parameters.

Standard Selection Screen
• Plan Version

You can specify the plan version for which you want to start a report.

• Object Type
You can specify the object type for which you want to start a report.

• Object ID
You can specify the object with which you want to start a report.

• Object Status
You can specify that only objects with a certain status can be reported on.

• Data Status
You can specify that only data with a certain status can be reported on.

• Set Structure Conditions
You can set various structure conditions.

• Evaluation Path
Via the evaluation path, you can specify the objects in a structure that are to be reported
on.



Organizational Plan Mode  SAP AG

Reports in Organizational Management

136 December 1999

• Status Vector
You can specify that only objects whose relationship infotypes (assignments) have a
certain status can be reported on.

• Status Overlap
You can execute a simulation that displays the results as though all relationship infotypes
were active.

• Display Depth
You can specify the level of a structure to which the report is to be executed.
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Existing Organizational Units (Report RHXEXI00)
Use
This report provides an overview of all existing organizational units.

Integration
This report is also accessed by other reports and transactions.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all organizational units, with information on

• validity period

• status

• name

• object ID
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Staff Functions for Organizational Units (Report
RHXSTAB0)
Use
This report displays all organizational units and their staff functions.

Prerequisites
So that you can report on organizational units with staff functions, you must have flagged them
with the staff indicator.

• Select the Staff field for the organizational unit in the Organization and Staffing view. For
more information, see Basic Data (Organizational Unit) [Page 64].

• Create a record for infotype 1003 for the organizational unit in Expert Mode. For more
information, see Department/Staff (Infotype 1003) [Ext.].

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all organizational units and their staff functions, with information on

• status

• validity

Activities
Once the report is started, the number of objects found is displayed. To display individual objects,
choose Organizational Unit by double-clicking on it.
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Organizational Structure with Persons (Report
RHXSTR02)
Use
This report displays the persons who belong to each organizational unit.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
A structure tree appears, which displays the organizational structure and the persons who belong
to it. The hierarchy levels are shown by corresponding indentations in the tree structure.
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Organizational Structure with Work Centers (Report
RHXSTR02)
Use
This report displays the work centers which belong to each organizational unit.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
A structure tree appears, which displays the organizational structure and the work centers which
belong to it. The hierarchy levels are shown by corresponding indentations in the tree structure.



 SAP AG Organizational Plan Mode

Existing Jobs (Report RHXEXI02)

December 1999 141

Existing Jobs (Report RHXEXI02)
Use
This report provides an overview of all existing jobs.

Integration
This report is also accessed by other reports and transactions.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all jobs, with information on

• validity period

• status

• name

• object ID



Organizational Plan Mode  SAP AG

Job Index (Report RHSTEL00)

142 December 1999

Job Index (Report RHSTEL00)
Use
This report enables you to display all existing jobs.

Features
Selection
In addition to the general selection parameters [Page 135], the following selection parameters
are available:

• Directly assigned persons
You can specify whether you want to display the persons directly assigned to the jobs.

Output
The list contains all jobs, with information on

• the positions assigned to them

• the holders of the positions assigned

• staffing percentage of the assigned positions
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Job Description (Report RHXDESC0)
Use
This report lists all jobs and their job descriptions.

Integration
This is a preliminary report for general report Object description (RHDESC20).

The complete job description [Page 144] report provides a complete job description.

Prerequisites
So that you can report on job descriptions, you must have created descriptions for jobs.

• You can create a description in the Organization and Staffing view. For more information, see
Basic Data (Job) [Page 80].

• Create a record for infotype 1002 for the job in Expert Mode. For more information, see
Description (Infotype 1002) [Ext.].

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all jobs, with information on

• name

• validity

• description

Activities
Use the buttons  and  to navigate through the list.
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Complete Job Description (Report RHXSCRP0)
Use
This reports lists all jobs along with specifications on their description, requirements profile, task
profile and resources and authorities.

Prerequisites
So that you can report on descriptions, you must have created descriptions for jobs.

• You can create a description in the Organization and Staffing view. For more information, see
Basic Data (Job) [Page 80].

• Create a record for infotype 1002 for the job in Expert Mode. For more information, see
Authorities/Resources (Infotype 1010) [Ext.].

To report on authorities and resources, you must have maintained a record for infotype infotype
1010. For more information, see Description (Infotype 1002) [Ext.].

You can only report on the requirements profile for jobs if the Personnel Development component
is installed.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all jobs, with information on

• name

• description

• authorities and resources

• requirements profile

• task profile

Activities
Use the buttons  and  to navigate through the list.
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Periods for Unoccupied Positions (Report RHFILLPOS)
Use
This report displays the periods in which assigned positions are unoccupied per organizational
unit.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Use the evaluation path SBESX if you want to report on all the positions in an
organizational  structure. The system starts the report for the organizational unit you
enter and reports accordingly on all the organizational units below it.

If you are, however, using the evaluation path SBES, only the positions belonging to
the organizational unit you have entered are reported on.

Output
The list contains all relevant positions by organizational unit, with information on

• the period for which the position is unoccupied

• new holder

• number of unoccupied days

• average of unoccupied days per organizational unit
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Existing Positions (Report RHXEXI03)
Use
This report provides an overview of all existing positions.

Integration
This report is also accessed by other reports and transactions.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all positions, with information on

• validity period

• status

• name

• object ID
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Staff Assignments (Report RHSBES00)
Use
This report enables you to display the staff assignments (positions and persons) for one or more
organizational units.

Features
Selection
In addition to the general selection parameters [Page 135], the following selection criteria are
available:

• Organizational unit
You enter the organizational unit for which you want to start the report.

• Status
You can specify whether active, planned, submitted, approved or rejected objects are to
be displayed.

• Report on Organizational Structure
You can specify whether only the selected organizational unit is to be reported on, or
whether all the organizational units assigned to it are to be taken into account as well.

• Basis for Working Time
You can display working times in hours per day, per week, per month or per year.

• Display Holders Only
You can either display the position holders or the holders and their substitutes.

• Persons without Positions
You can also display persons who are not assigned a position.

Output
The list contains all positions by organizational unit, with information on

• the persons assigned to the positions

• chief positions

• staffing status

• actual working times

• planned working times

• staffing percentages

• assignment to employee groups

• assignment to employee subgroups
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Position Description (Report RHXDESC1)
Use
This report lists all positions and their position descriptions.

Integration
This is a preliminary report for general report Object description (RHDESC20).

The complete position description [Page 155] report provides a complete position description.

Prerequisites
So that you can report on position descriptions, you must have created descriptions for positions.

• You can create a description in the Organization and Staffing view. For more information, see
Basic Data (Position) [Page 88].

• Create a record for infotype 1002 for the position in Expert Mode. For more information, see
Description (Infotype 1002) [Ext.].

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all positions, with information on

• name

• validity

• description

Activities
Use the buttons  and  to navigate through the list.
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Staff Functions for Positions (Report RHXSTAB1)
Use
This report displays all positions and their staff functions.

Prerequisites
So that you can report on positions with staff functions, you must have flagged them with the staff
indicator.

• Select the Staff field for the position in the Organization and Staffing view. For more
information, see Basic Data (Position) [Page 88].

• Create a record for infotype 1003 for the position in Expert Mode. For more information, see
Department/Staff (Infotype 1003) [Ext.].

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all positions and their staff functions, with information on

• status

• validity

Activities
Once the report is started, the number of objects found is displayed. To display individual objects,
choose Position by double-clicking on it.
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Authorities and Resources (Report RHXHFMT0)
Use
This report lists all positions or work centers with the resources and authorities entered for them.

Prerequisites
To report on authorities and resources, you must have maintained the subtypes of infotype 1010
for positions/work centers in Expert Mode. For more information, see Authorities/Resources
(Infotype 1010) [Ext.].

Features
Selection
In addition to the general selection parameters [Page 135], the following selection parameters
are available:

• Authorities/Resources
You can choose between the two subtypes of infotype 1010, Authorities/Powers of
Attorney and Technical Resources.

Output
The list contains all positions or work centers, with information on

• name

• status

• authorities and resources
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Planned Labor Costs (Report RHSOLO00/RHXSOLO00)
Use
This report enables you to determine the planned labor costs per position or work center for one
or more organizational units.

Prerequisites
The Planned Remuneration (1005) [Ext.] infotype is valid for the positions/work centers
belonging to the organizational unit concerned or for the relevant jobs.

Features
Selection
In addition to the general selection parameters [Page 135], the following selection parameters
are available:

• Currency
You can select the currency in which you want the data to be displayed.

• Conversion type It. TCURR
You can enter an exchange rate type.

• Values
You can decide how the planned remuneration band widths are to be set up.

• Periods
You can specify the unit of time that is to be used to calculate or display the amount in
compensation administration.

Output
The list contains all positions or work centers per organizational unit, with information on

• amount

• currency
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Vacant Positions (Report RHVOPOS0)
Use
This report enables you to display all positions that are flagged as vacant. A vacant position is a
position that has no holder during a particular period and is flagged as vacant.

Prerequisites
So that you can report on vacant positions, you must have flagged them as vacant:

• Flag a position as Vacancy open in the Organization and Staffing view. For more information,
see Position [Page 20].

• Create a record for infotype 1007 for the position in Expert Mode. For more information, see
Vacancy (Infotype 1007) [Ext.].

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all vacant positions by organizational unit, with information on

• period of vacancy

• staffing status
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Obsolete Positions (Report RHVOPOS1)
Use
This report enables you to display all positions that are flagged as obsolete. An obsolete position
is a position that is removed at a particular time.

Prerequisites
So that you can report on obsolete positions, you must have flagged them as obsolete:

• Flag a position as obsolete in the Organization and Staffing view. For more information, see
Position [Page 20].

• Create a record for infotype 1014 for the position in Expert Mode. For more information, see
Obsolete (Infotype 1014) [Ext.].

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all obsolete positions by organizational unit, with information on

• the period in which the position is obsolete

• staffing status
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Complete Position Description (Report RHXSCRP1)
Use
This report lists all positions and the numerous characteristics which describe them.

Prerequisites
So that you can report on these characteristics, the relevant infotypes must be maintained and
the corresponding relationships available.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all positions, with information on

• description

• staffing (holder of a position)

• superior and subordinate positions

• activity profile of the position

• requirements profile (only if the Personnel Development component is installed)

• describing job

• activity profile of the job

• requirements profile of the job (only if the Qualifications/Requirements component is
installed)

• work center assigned to the position

• integration of the position in the organization

Using the object description function, you can display further information, such as
Resources/Authorities etc.

Activities
Use the buttons  and  to navigate through the list.

You can edit infotypes by choosing Goto → Object description.



Organizational Plan Mode  SAP AG

Complete Position Description (Report RHXSCRP1)

156 December 1999



 SAP AG Organizational Plan Mode

Reporting Structure without Persons (Report RHSTR05)

December 1999 157

Reporting Structure without Persons (Report RHSTR05)
Use
This report lists the subordinate positions for each position selected.

Integration
Report RHDTRU04 enables you to display a Reporting Structure with Persons [Page 158].

Prerequisites
To report on a reporting structure, you must have created a reporting structure. To do this, you
must subordinate positions to one another:

• You can create a hierarchy in the Organization and Staffing view. For more information, see
Hierarchy (Position) [Ext.].

• You can create a reporting structure in Expert Mode. For more information, see Reporting
Structures [Ext.].

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
A structure tree appears, which displays the subordination and superordination of positions. The
hierarchy levels are shown by corresponding indentations in the tree structure.
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Reporting Structure with Persons (Report RHSTR04)
Use
This report lists the subordinate positions for each position selected. All position holders are also
displayed.

Integration
Report RHDTRU05 enables you to display a Reporting Structure without Persons (Report) [Page
157].

Prerequisites
To report on a reporting structure, you must have created a reporting structure. To do this, you
must subordinate positions to one another:

• You can create a hierarchy in the Organization and Staffing view. For more information, see
Hierarchy (Position) [Ext.].

• You can create a reporting structure in Expert Mode. For more information, see Reporting
Structures [Ext.].

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
A structure tree appears, which displays the subordination and superordination of positions as
well as the assignment of persons to positions. The hierarchy levels are shown by corresponding
indentations in the tree structure.



 SAP AG Organizational Plan Mode

Existing Work Centers (Report RHXEXI05)

December 1999 159

Existing Work Centers (Report RHXEXI05)
Use
This report provides an overview of all existing work centers.

Integration
This report is also accessed by other reports and transactions.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all work centers, with information on

• validity period

• status

• name

• object ID



Organizational Plan Mode  SAP AG

Work Centers per Organizational Unit (Report RHXSTRU06)

160 December 1999

Work Centers per Organizational Unit (Report
RHXSTRU06)
Use
This report lists the work centers assigned to each organizational unit.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
A structure tree appears, which displays the assignment of work centers to organizational units.
The hierarchy levels are shown by corresponding indentations in the tree structure.
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Existing Tasks (Report RHXEXI04)
Use
This report provides an overview of all existing tasks.

Integration
This report is also accessed by other reports and transactions.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all tasks, with information on

• validity period

• status

• name

• object ID
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Activity Profile of Positions (Report RHXSTR07)
Use
This report displays the positions belonging to an organizational unit, as well as the directly or
indirectly (via job) assigned tasks and the assigned persons.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
A structure tree appears, which displays the assignment of tasks and persons to positions. The
hierarchy levels are shown by corresponding indentations in the tree structure.
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Activity Profile of Positions with Persons (Report
RHXSTR08)
Use
This report displays the positions belonging to an organizational unit, as well as the directly or
indirectly (via job) assigned tasks.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
A structure tree appears, which displays the assignment of tasks to positions. The hierarchy
levels are shown by corresponding indentations in the tree structure.
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Existing Objects (Report RHEXIST0)
Use
This report provides an overview of all existing objects.

Integration
This report is also accessed by other reports and transactions.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
The list contains all objects, with information on

• validity period

• status

• name

• object ID
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Structure Display/Maintenance (RHSTRU00)
Use
This report displays a section of the organizational plan according to the initial object and
evaluation path entered.

Prerequisites
The evaluation path you enter must appear in table T778A.

Features
Selection
For more information on the selection parameters, see Reports in Organizational Management
[Page 135].

Output
A structure tree appears, which displays the assignment of organizational objects to one another.
The hierarchy levels are shown by corresponding indentations in the tree structure.
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Reporting on an Infotype (Report RHINFAW0)
Use
This report enables you to report on any infotype. This can be executed structurally or
sequentially (in other words, along a structure using an evaluation path according to table
T77AW/T778A). The report can also be used for infotypes that you have created yourself.

Features
Selection
In addition to the general selection parameters [Page 135], the following selection parameters
are available:

• Infotype
You can specify the infotype that you wish to report on.

• Subtype
You can specify the subtype that you wish to report on.

• Reporting on an Infotype Field
You can specify the field entries of the infotype records that are to be displayed.

• Selecting an Infotype Field
You can select the fields, whose entries you wish to display.

• All Objects
You can specify that the objects for which there is no record for the infotype be displayed
as well.

• Objects without this Infotype
You can specify that only those objects for which there is no record for the infotype be
displayed.
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Starting an HR Report (Report RHPNPSUB)
Use
Using this program, you can start various reports for a number of personnel numbers. The
reports will draw on information from the structures in the organizational plan.

Features
Selection
The following selection parameters are available in addition to the general selection parameters
[Page 135]:

• HR Reporting
Enter the name of the report you want to start.

• Report Variants
You can select a report variant.

• Enhanced HR Selection
You can use additional selection parameters.

• Sort by Personnel Number
Sorting is possible.

Output
The output depends on the report you select.


